# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copyright</td>
<td>11</td>
</tr>
<tr>
<td>About Audinate</td>
<td>12</td>
</tr>
<tr>
<td>About Dante</td>
<td>12</td>
</tr>
<tr>
<td>Introduction</td>
<td>13</td>
</tr>
<tr>
<td>About Dante Controller</td>
<td>13</td>
</tr>
<tr>
<td>What's New</td>
<td>14</td>
</tr>
<tr>
<td>v4.9.0</td>
<td>14</td>
</tr>
<tr>
<td>v4.8.1</td>
<td>14</td>
</tr>
<tr>
<td>v4.7.0</td>
<td>14</td>
</tr>
<tr>
<td>v4.6.0</td>
<td>14</td>
</tr>
<tr>
<td>v4.5.1</td>
<td>14</td>
</tr>
<tr>
<td>v4.4.0</td>
<td>14</td>
</tr>
<tr>
<td>v4.3.3</td>
<td>14</td>
</tr>
<tr>
<td>v4.2.5</td>
<td>15</td>
</tr>
<tr>
<td>System Requirements</td>
<td>15</td>
</tr>
<tr>
<td>General</td>
<td>15</td>
</tr>
<tr>
<td>Windows</td>
<td>15</td>
</tr>
<tr>
<td>macOS</td>
<td>15</td>
</tr>
<tr>
<td>Operating System Updates</td>
<td>16</td>
</tr>
<tr>
<td>Firewall Configuration</td>
<td>16</td>
</tr>
<tr>
<td>Installing Dante Controller</td>
<td>17</td>
</tr>
<tr>
<td>Downloading Dante Controller</td>
<td>17</td>
</tr>
<tr>
<td>Installing Dante Controller on Windows</td>
<td>17</td>
</tr>
<tr>
<td>Installing Dante Controller on macOS</td>
<td>17</td>
</tr>
<tr>
<td>Updating Dante Controller</td>
<td>18</td>
</tr>
<tr>
<td>Checking for Updates Manually</td>
<td>18</td>
</tr>
<tr>
<td>Checking for Updates Automatically</td>
<td>18</td>
</tr>
<tr>
<td>Uninstalling Dante Controller</td>
<td>18</td>
</tr>
<tr>
<td>Windows</td>
<td>18</td>
</tr>
<tr>
<td>macOS</td>
<td>18</td>
</tr>
<tr>
<td>Dante Basics</td>
<td>19</td>
</tr>
<tr>
<td>Discovery and auto-configuration</td>
<td>19</td>
</tr>
<tr>
<td>Automatic network configuration</td>
<td>19</td>
</tr>
<tr>
<td>Automatic discovery</td>
<td>19</td>
</tr>
<tr>
<td>Device Channels</td>
<td>19</td>
</tr>
<tr>
<td>Subscribing to Media Channels</td>
<td>20</td>
</tr>
<tr>
<td>Subscribing to Multiple Media Channels at once</td>
<td>20</td>
</tr>
<tr>
<td>Unsubscribing Media Channels</td>
<td>20</td>
</tr>
<tr>
<td>Subscription Status</td>
<td>20</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Subscription Tooltips</td>
<td>21</td>
</tr>
<tr>
<td>Differentiating Between Input and Output Channels</td>
<td>22</td>
</tr>
<tr>
<td>Device and Channel Names</td>
<td>22</td>
</tr>
<tr>
<td>Rules for Names</td>
<td>23</td>
</tr>
<tr>
<td>Routing Media</td>
<td>23</td>
</tr>
<tr>
<td>Routing Terminology</td>
<td>23</td>
</tr>
<tr>
<td>Subscription</td>
<td>24</td>
</tr>
<tr>
<td>Redundancy</td>
<td>24</td>
</tr>
<tr>
<td>Media Formats</td>
<td>25</td>
</tr>
<tr>
<td>Flows</td>
<td>25</td>
</tr>
<tr>
<td>Advanced Routing: Using Multicast</td>
<td>25</td>
</tr>
<tr>
<td>Routing for Video Devices</td>
<td>26</td>
</tr>
<tr>
<td>Audio Channels</td>
<td>26</td>
</tr>
<tr>
<td>Video Channels</td>
<td>26</td>
</tr>
<tr>
<td>Ancillary Channels</td>
<td>26</td>
</tr>
<tr>
<td>Clock Synchronization</td>
<td>28</td>
</tr>
<tr>
<td>In Standard Dante Networks</td>
<td>28</td>
</tr>
<tr>
<td>Dante Clock Types</td>
<td>28</td>
</tr>
<tr>
<td>Clock Settings</td>
<td>28</td>
</tr>
<tr>
<td>Enable Sync To External</td>
<td>28</td>
</tr>
<tr>
<td>Preferred Leader</td>
<td>28</td>
</tr>
<tr>
<td>Clocking and Synchronization in Redundant Networks</td>
<td>28</td>
</tr>
<tr>
<td>In Dante Domains</td>
<td>29</td>
</tr>
<tr>
<td>Latency</td>
<td>29</td>
</tr>
<tr>
<td>For Audio Devices</td>
<td>29</td>
</tr>
<tr>
<td>Latency Monitoring</td>
<td>29</td>
</tr>
<tr>
<td>Latency and Dante Virtual Soundcard</td>
<td>30</td>
</tr>
<tr>
<td>Latency in DDM Networks</td>
<td>30</td>
</tr>
<tr>
<td>For Video Devices</td>
<td>30</td>
</tr>
<tr>
<td>Device Lock</td>
<td>30</td>
</tr>
<tr>
<td>Locking a Dante device</td>
<td>31</td>
</tr>
<tr>
<td>Using Device View</td>
<td>31</td>
</tr>
<tr>
<td>From the Device Info Tab</td>
<td>31</td>
</tr>
<tr>
<td>Unlocking a Dante Device</td>
<td>31</td>
</tr>
<tr>
<td>Using Device View</td>
<td>31</td>
</tr>
<tr>
<td>From the Device Info Tab</td>
<td>31</td>
</tr>
<tr>
<td>Unlocking a Device When You Have Forgotten the PIN</td>
<td>31</td>
</tr>
<tr>
<td>How to Isolate a Device from the Rest of the Dante Network</td>
<td>32</td>
</tr>
<tr>
<td>Option 1: Remove all other Dante devices from the Dante network</td>
<td>32</td>
</tr>
<tr>
<td>Option 2: Connect your Dante Controller computer directly to the device</td>
<td>32</td>
</tr>
<tr>
<td>Option 3: Use a VLAN</td>
<td>32</td>
</tr>
</tbody>
</table>
Starting Dante Controller .................................................. 34
Where to find the Dante Controller application .................. 34
Windows ........................................................................... 34
macOS ............................................................................. 34
Configuring Dante Controller ............................................. 34
Network Interface Selection .............................................. 34
Use Shared Dante Interface .............................................. 36
Wi-Fi Network Connections .............................................. 36
Network Interface Configuration Guidelines ....................... 36
Primary only (non-redundant) Dante network ................. 36
Primary and secondary Dante networks (redundant configuration), only one network interface on the host computer .................................................. 37
Primary and secondary networks (redundant configuration), two network interfaces on the host computer .................. 38
Connection via Wi-Fi ....................................................... 39
Using Wi-Fi and Multicast Transmit Flows ......................... 40
Remedial action ................................................................ 40
Using Dante Controller ..................................................... 42
Network View .................................................................... 42
Menu bar .......................................................................... 43
File ................................................................................ 43
Devices .......................................................................... 43
View ............................................................................... 44
Help ................................................................................ 44
Tool bar ........................................................................... 44
Tabs ................................................................................. 45
Status Bar ........................................................................ 45
DDM Networks .................................................................. 45
Status Bar ........................................................................ 46
Network View Tabs .......................................................... 46
Routing View ..................................................................... 46
Expanding the Routing View .......................................... 47
Device List Filtering .......................................................... 47
Advanced Filter ................................................................ 48
About the Advanced Filter .............................................. 48
Text Filter ........................................................................ 48
Device State and Configuration Filters .............................. 49
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Groups</td>
<td>51</td>
</tr>
<tr>
<td>Device Info</td>
<td>52</td>
</tr>
<tr>
<td>Clock Status</td>
<td>53</td>
</tr>
<tr>
<td>Device Name</td>
<td>53</td>
</tr>
<tr>
<td>Sync</td>
<td>53</td>
</tr>
<tr>
<td>Mute</td>
<td>53</td>
</tr>
<tr>
<td>Clock Source</td>
<td>53</td>
</tr>
<tr>
<td>Domain Status (DDM networks only)</td>
<td>53</td>
</tr>
<tr>
<td>Primary v1 Multicast</td>
<td>54</td>
</tr>
<tr>
<td>Primary v2 Multicast</td>
<td>54</td>
</tr>
<tr>
<td>Secondary v1 Multicast</td>
<td>54</td>
</tr>
<tr>
<td>Secondary v1 Multicast</td>
<td>54</td>
</tr>
<tr>
<td>Preferred Leader</td>
<td>54</td>
</tr>
<tr>
<td>Enable Sync To External</td>
<td>54</td>
</tr>
<tr>
<td>About Clock Domains</td>
<td>55</td>
</tr>
<tr>
<td>In DDM Networks</td>
<td>55</td>
</tr>
<tr>
<td>About Leader Clocks</td>
<td>55</td>
</tr>
<tr>
<td>Clock Status Monitoring</td>
<td>56</td>
</tr>
<tr>
<td>Why would a device clock be unstable?</td>
<td>56</td>
</tr>
<tr>
<td>Passive monitoring</td>
<td>56</td>
</tr>
<tr>
<td>Active Monitoring</td>
<td>56</td>
</tr>
<tr>
<td>Clock Status Monitor</td>
<td>57</td>
</tr>
<tr>
<td>Log</td>
<td>57</td>
</tr>
<tr>
<td>History</td>
<td>58</td>
</tr>
<tr>
<td>About Clock Offset</td>
<td>59</td>
</tr>
<tr>
<td>About the Histogram</td>
<td>59</td>
</tr>
<tr>
<td>Interpreting the Histogram</td>
<td>60</td>
</tr>
<tr>
<td>Network Status</td>
<td>62</td>
</tr>
<tr>
<td>Device Name</td>
<td>62</td>
</tr>
<tr>
<td>Subscription Status</td>
<td>62</td>
</tr>
<tr>
<td>Primary Status</td>
<td>62</td>
</tr>
<tr>
<td>Secondary Status</td>
<td>62</td>
</tr>
<tr>
<td>Bandwidth Columns</td>
<td>62</td>
</tr>
<tr>
<td>Latency Setting</td>
<td>63</td>
</tr>
<tr>
<td>Latency Errors</td>
<td>63</td>
</tr>
<tr>
<td>Packet Errors</td>
<td>63</td>
</tr>
<tr>
<td>Events</td>
<td>64</td>
</tr>
<tr>
<td>Filtering the Event List</td>
<td>64</td>
</tr>
<tr>
<td>Clearing the Event List</td>
<td>64</td>
</tr>
<tr>
<td>Saving the Event Log</td>
<td>64</td>
</tr>
<tr>
<td>Automatic event logging</td>
<td>65</td>
</tr>
</tbody>
</table>
Event Classification ........................................................................ 65
Automatic Notification of Device Errors ........................................... 66
Incorrect IP address configuration ......................................................... 66
Failsafe mode ............................................................................. 66
Upgrade mode ............................................................................. 66
Other Event Notifications ................................................................. 67
Device View ............................................................................... 67
Device View Menu bar .................................................................. 69
File ......................................................................................... 69
Devices ..................................................................................... 69
View ......................................................................................... 69
Help ........................................................................................ 69
Device View Toolbar ................................................................... 69
Device View Tabs ........................................................................ 70
Receive Tab ............................................................................... 70
Receive Channels ........................................................................ 70
Available Channels ....................................................................... 72
AES67 Flows ............................................................................. 72
Creating Subscriptions ................................................................. 72
Changing Receive Channel Names ................................................. 72
Transmit Tab ............................................................................... 72
Changing Tx channel Names .......................................................... 74
Status Tab .................................................................................. 74
Device Information ....................................................................... 75
Dante Information ....................................................................... 75
Clock Synchronization ................................................................... 76
Primary Interface .......................................................................... 76
Secondary Interface ...................................................................... 77
Latency Tab .................................................................................. 77
About Latency and Packet Loss ....................................................... 77
About the Histogram .................................................................... 78
Interpreting the Histogram ............................................................. 79
Device Config Tab ........................................................................ 81
Configurable Parameters ................................................................. 82
Rename Device ............................................................................. 82
Sample Rate ................................................................................ 82
Preferred Encoding ...................................................................... 83
Unicast Delay Requests ................................................................ 83
Device Latency ............................................................................. 83
Reset Device ................................................................................ 84
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugins</td>
<td>84</td>
</tr>
<tr>
<td>Network Config Tab</td>
<td>85</td>
</tr>
<tr>
<td>Dante Redundancy / Switch Configuration</td>
<td>86</td>
</tr>
<tr>
<td>Redundant</td>
<td>86</td>
</tr>
<tr>
<td>Switched</td>
<td>86</td>
</tr>
<tr>
<td>Switch Configuration</td>
<td>86</td>
</tr>
<tr>
<td>Addresses</td>
<td>86</td>
</tr>
<tr>
<td>Interop Status Tab</td>
<td>87</td>
</tr>
<tr>
<td>AES67 Config</td>
<td>88</td>
</tr>
<tr>
<td>AES67 Mode</td>
<td>89</td>
</tr>
<tr>
<td>RTP Multicast Address Prefix</td>
<td>89</td>
</tr>
<tr>
<td>Controls Tab</td>
<td>90</td>
</tr>
<tr>
<td>HA Remote Tab</td>
<td>90</td>
</tr>
<tr>
<td>Avid Config Tab</td>
<td>91</td>
</tr>
<tr>
<td>Avid Dante Card Information</td>
<td>92</td>
</tr>
<tr>
<td>Application version</td>
<td>92</td>
</tr>
<tr>
<td>FPGA Version</td>
<td>92</td>
</tr>
<tr>
<td>Board Version</td>
<td>92</td>
</tr>
<tr>
<td>Avid Rack Status Information</td>
<td>92</td>
</tr>
<tr>
<td>Rack Sample Rate</td>
<td>93</td>
</tr>
<tr>
<td>Rack Mute Status</td>
<td>93</td>
</tr>
<tr>
<td>Avid Dante card Control</td>
<td>93</td>
</tr>
<tr>
<td>Card Configuration</td>
<td>93</td>
</tr>
<tr>
<td>SRC</td>
<td>93</td>
</tr>
<tr>
<td>Card Identity</td>
<td>93</td>
</tr>
<tr>
<td>Flow Information</td>
<td>93</td>
</tr>
<tr>
<td>Multicast Transmit Flow Configuration</td>
<td>94</td>
</tr>
<tr>
<td>Maximum Channels per Flow (Audio Devices Only)</td>
<td>96</td>
</tr>
<tr>
<td>Managing Flow Size</td>
<td>96</td>
</tr>
<tr>
<td>Deleting Multicast Flows</td>
<td>97</td>
</tr>
<tr>
<td>AES67 Flow</td>
<td>98</td>
</tr>
<tr>
<td>SMPTE Flows</td>
<td>98</td>
</tr>
<tr>
<td>Creating SMPTE Flows</td>
<td>99</td>
</tr>
<tr>
<td>Subscribing to SMPTE Flows</td>
<td>100</td>
</tr>
<tr>
<td>Using Dante Controller with Dante Domain Manager</td>
<td>102</td>
</tr>
<tr>
<td>About Dante Domain Manager</td>
<td>102</td>
</tr>
<tr>
<td>Viewing Domains in Dante Controller</td>
<td>102</td>
</tr>
<tr>
<td>Connecting to a DDM Server</td>
<td>102</td>
</tr>
<tr>
<td>First-time Connections</td>
<td>103</td>
</tr>
<tr>
<td>Viewing a Domain</td>
<td>104</td>
</tr>
<tr>
<td>Virtual Devices</td>
<td>104</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Legacy Devices</td>
<td>106</td>
</tr>
<tr>
<td>Hidden Legacy Devices</td>
<td>106</td>
</tr>
<tr>
<td>Domain Credentials</td>
<td>106</td>
</tr>
<tr>
<td><strong>Presets</strong></td>
<td>108</td>
</tr>
<tr>
<td>About Device Roles</td>
<td>108</td>
</tr>
<tr>
<td>Saving Presets</td>
<td>109</td>
</tr>
<tr>
<td>Parameter Rules</td>
<td>109</td>
</tr>
<tr>
<td>Rx Subscriptions</td>
<td>109</td>
</tr>
<tr>
<td>Tx Flows (multicast flows)</td>
<td>110</td>
</tr>
<tr>
<td>Tx Channel Names</td>
<td>110</td>
</tr>
<tr>
<td>Applying Presets</td>
<td>110</td>
</tr>
<tr>
<td>Preset Elements</td>
<td>111</td>
</tr>
<tr>
<td>Preset Roles</td>
<td>111</td>
</tr>
<tr>
<td>Automatic Assignments</td>
<td>112</td>
</tr>
<tr>
<td>Manual Assignments</td>
<td>113</td>
</tr>
<tr>
<td>Target Devices</td>
<td>113</td>
</tr>
<tr>
<td>Issues</td>
<td>114</td>
</tr>
<tr>
<td>Applying the Preset</td>
<td>115</td>
</tr>
<tr>
<td>Global Configuration</td>
<td>115</td>
</tr>
<tr>
<td><strong>Dante Updater</strong></td>
<td>117</td>
</tr>
<tr>
<td>Launching Dante Updater</td>
<td>117</td>
</tr>
<tr>
<td><strong>Troubleshooting</strong></td>
<td>119</td>
</tr>
<tr>
<td>Fanout</td>
<td>119</td>
</tr>
<tr>
<td>About Transmit Flows</td>
<td>119</td>
</tr>
<tr>
<td>Messages on Startup</td>
<td>120</td>
</tr>
<tr>
<td>Computer Configuration Checklist</td>
<td>120</td>
</tr>
<tr>
<td>Third-party firewall configuration</td>
<td>120</td>
</tr>
<tr>
<td>Troubleshooting Dante IP Address Configuration</td>
<td>121</td>
</tr>
<tr>
<td>Correct IP configuration</td>
<td>121</td>
</tr>
<tr>
<td>Possible IP network configuration mistakes</td>
<td>121</td>
</tr>
<tr>
<td>Incorrect PC/Mac IP configuration</td>
<td>121</td>
</tr>
<tr>
<td>Incorrect general IP configuration</td>
<td>121</td>
</tr>
<tr>
<td>Incorrect redundant network configuration</td>
<td>121</td>
</tr>
<tr>
<td>What are the symptoms of using the wrong network interface on my computer?</td>
<td>122</td>
</tr>
<tr>
<td>How do I check which network interfaces Dante Controller is using?</td>
<td>122</td>
</tr>
<tr>
<td>How do I check IP addresses for all devices on my network?</td>
<td>122</td>
</tr>
<tr>
<td>Troubleshooting Switch Configuration and Cabling</td>
<td>123</td>
</tr>
<tr>
<td>Symptoms of switch or cabling issues</td>
<td>123</td>
</tr>
<tr>
<td>Switch and Cabling Checklist</td>
<td>123</td>
</tr>
<tr>
<td><strong>Appendix</strong></td>
<td>124</td>
</tr>
<tr>
<td>Resolution and Timing for Dante AV Devices</td>
<td>124</td>
</tr>
</tbody>
</table>
Automatic Operation ................................................................. 124
Manual Operation ................................................................. 125
Index ................................................................................. 127
## Contacts

### Audinate Pty Ltd
Level 7, 64 Kippax Street  
Surry Hills NSW 2010  
Australia  
Tel. +61 2 8090 1000  
[info@audinate.com](mailto:info@audinate.com)  
[www.audinate.com](http://www.audinate.com)

### Audinate Inc
1200 NW Naito Parkway  
Suite 630  
Portland, OR 97209  
USA  
Tel: +1.503.224.2998  
Fax. +1.503.360.1155

### European Office
Audinate Ltd  
Future Business Centre  
Kings Hedges Rd  
Cambridge CB4 2HY  
United Kingdom  
Tel. +44 (0) 1273 921695

### Asia Pacific Office
Audinate Limited  
Suite 1106-08, 11/F Tai Yau Building  
No 181 Johnston Road  
Wanchai, Hong Kong  
澳迪耐特有限公司  
香港灣仔莊士敦道181號  
大有大廈11樓1106-8室  
Tel. +(852)-3588 0030  
+(852)-3588 0031  
Fax. +(852)-2975 8042
Copyright

© 2023 Audinate Pty Ltd. All Rights Reserved.
Audinate®, the Audinate logo and Dante® are registered trademarks of Audinate Pty Ltd.
All other trademarks are the property of their respective owners.
Audinate products are protected by one or more of US Patents 7747725, 8005939, 7978696, 8171152, European Patent 2255541, Chinese Patent ZL200780026677.0, and other patents pending or issued.
See www.audinate.com/patents.

Legal Notice and Disclaimer

Audinate retains ownership of all intellectual property in this document.
The information and materials presented in this document are provided as an information source only.
While effort has been made to ensure the accuracy and completeness of the information, no guarantee
is given nor responsibility taken by Audinate for errors or omissions in the data.
Audinate is not liable for any loss or damage that may be suffered or incurred in any way as a result of
acting on information in this document. The information is provided solely on the basis that readers will
be responsible for making their own assessment, and are advised to verify all relevant representation,
statements and information with their own professional advisers.

Software Licensing Notice

Audinate distributes products which are covered by Audinate license agreements and third-party license
agreements.
For further information and to access copies of each of these licenses, please visit our website:
www.audinate.com/software-licensing-notice
About Audinate

Audinate® is the leading provider of professional AV networking technologies globally. Audinate's Dante platform distributes digital audio and video signals over computer networks, and is designed to bring the benefits of IT networking to the professional AV industry. AV-over-IP (AVoIP) using Dante-enabled products ensures interoperability between AV devices and allows end users to enjoy high quality, flexible solutions – typically with a lower total cost of ownership.

About Dante

Dante is the de facto standard digital media networking solution, using standard IP infrastructure to network devices, and making interoperability easy and reliable. It distributes uncompressed, multi-channel digital media via standard Ethernet networks, with near-zero latency and perfect synchronization.

It's the most economical, versatile, and easy-to-use media networking solution, and is scalable from simple installations to large-capacity networks running thousands of channels. Dante can replace multiple analog or multicore cables with a single affordable Ethernet cable to transmit high-quality multi-channel media safely and reliably. With Dante software, the network can be easily expanded and reconfigured with just a few mouse clicks. Dante technology powers products available from hundreds of partners around the world.

For more information, please visit the Audinate website at www.audinate.com.
Introduction

About Dante Controller

Dante Controller is a software application provided by Audinate which allows users to configure and route audio and video around Dante networks. It is available for Windows and macOS (see Minimum System Requirements for more details).

Once you install Dante Controller on your PC or Mac and connect it to a Dante network, you can use Dante Controller to:

- View all Dante-enabled audio and video devices and their channels on the network
- View Dante-enabled device clock and network settings
- Route audio and video on these devices, and view the state of existing audio and video routes
- Route ancillary channels for AV devices
- Connect to Dante Domain Manager and control enrolled devices
- Lock and unlock Dante devices
- Rename device channels from numbers to names that suit you
- Customize the receive latency (latency before play out)
- Save audio and video routing presets
- Apply previously saved presets
- Edit presets offline, and apply as configurations for new network deployments
- View and set per-device configuration options, including:
  - Changing the device name
  - Changing sample rate and clock settings
  - Viewing detailed network information
  - Access the device web page to upgrade firmware and license information (where supported)
  - Identify a device for example by flashing LEDs (where supported)
- View network status information, including:
  - Multicast bandwidth across the network
  - Transmit and receive bandwidth for each device
- View device performance information, including latency statistics and packet errors
- View clock status information for each device, including frequency offset history and clock event logs
- Transmit and subscribe to AES67 RTP multicast audio flows, and SMPTE ST 2110-30 RTP multicast audio flows (DDM networks only)
- Configure AV devices via custom control interfaces

The Dante Controller installation package also installs Dante Updater and Dante Activator.
What's New

v4.9.0
- Improved notification on media flow vulnerability after Tx channel renaming
- Dante Controller support for auto-detection of video format for Dante Studio receive channels (requires Dante Studio v2.1.0 or above)

v4.8.1
- Dante Updater support for firmware update and failsafe recovery of newly-released Brooklyn 3 (Dante device type) hardware

v4.7.0
- Support for Dante AV and Bluetooth AVIO configuration in DDM/Dante Cloud environments

Previous releases

v4.6.0
- Support for multiple language options for the user interface: English, Spanish, French, German, Portuguese, Chinese, Japanese and Korean
  - To change the language, from Network view, select View > Language

v4.5.1
- Dante Activator is now installed with Dante Controller
  - Dante Activator is a new application that allows you to purchase and activate additional Dante channels for supporting Dante Ready™ devices.
- Support for Windows 11
- New DDM / Dante Cloud Login dialog (combines the DDM user and DDM server login functions)
- New feature: Connect Devices to DDM / Dante Cloud (for DDM networks)

v4.4.0
- Support for Apple M1 architecture
- Native support for 64-bit Windows
  - 32-bit Windows is no longer supported
- New user guide content: Resolution and Timing for Dante AV Devices

v4.3.3
- Support for Dante AV (video) devices. For more information, see:
  - Routing for Video Devices
  - Plugins
- New signal status icons for video and ancillary channels (Receive Tab and Transmit Tab)
- The Advanced Filter has been updated:
  - The Subscriptions filter now includes extra options
  - The Latency and Sample Rate filter options are now dynamic based on product type
  - New filters have been added for Media Type, Video Subtype, and Ancillary Type
- Channel labels have been deprecated - all channel names are now user-editable (Device and Channel Names)
- Inclusive language changes to clocking terminology:
  - Some of the terminology used in Dante products has been changed to align with modern usage. Specifically, areas related to Dante clocking now refer to “Primary Leader Clock”, “Leader Clocks” and “Follower Clocks” to describe the functions of each role more clearly.
- Support for macOS 11 Big Sur

For more information about new features, please see the Dante Controller release pages at audinate.com.

v4.2.5
Support for macOS 10.15.

System Requirements

The tables below list the system specifications for your computer to be able to use Dante Controller.

Disclaimer: It is possible that your computer may meet the requirements below, but suffer from some other individual performance limitation related to its particular hardware. Please seek the advice of your computer support administrator.

### General

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>1GHz or better</td>
</tr>
<tr>
<td>Memory</td>
<td>512Mbyte of RAM</td>
</tr>
<tr>
<td>Network</td>
<td>Standard wired Ethernet network interface (100Mbps or Gigabit) or wireless LAN (Wi-Fi) interface</td>
</tr>
</tbody>
</table>

### Windows

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 10 or 11</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong>: Both UTF-8 and Unicode are supported EXCEPT for host or device names; the DNS standard does not support Unicode for these</td>
</tr>
<tr>
<td>Hardware</td>
<td>64-bit architecture</td>
</tr>
</tbody>
</table>

### macOS

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>macOS 10.15, 11 or 12</td>
</tr>
<tr>
<td>Hardware</td>
<td>Intel or Apple M1</td>
</tr>
</tbody>
</table>
Operating System Updates

Ensure your PC or Mac has the latest Windows or Apple updates installed.

Firewall Configuration

Firewall configuration for Windows Firewall and macOS built-in firewall is automatically handled during installation.

If you are using a third-party firewall product, please refer to [this Audinate FAQ](#) for more information about Dante ports.
Installing Dante Controller

Downloading Dante Controller

Dante Controller is available for download from Audinate’s website.
To download a copy of Dante Controller:
2. Navigate to Products > Dante Controller.
3. Under 'Download', choose your operating system.
4. Click the red download button.

This will take you to the appropriate Dante Controller release page for your operating system.
Click the link under ‘File downloads' to download the Dante Controller installer.

Installing Dante Controller on Windows

Once you have downloaded the self-installing Dante Controller file, navigate to the directory where you have downloaded it (e.g. Desktop).
To install:
1. Ensure you are logged on to your PC as an administrator.
2. Navigate to and double-click the Dante Controller installer file.
3. Read the license agreement. If you agree to the terms, select the 'I agree' checkbox and click Install. If you do not agree to the terms, click Close.
4. Confirm / acknowledge any Windows security prompts that are displayed.

   Dante Controller will then be installed. Dante Controller will be added to the start menu, under 'Audinate'.

   Note: Dante Updater will also be installed automatically.

Installing Dante Controller on macOS

To install Dante Controller on macOS:
1. Double-click the Dante Controller .dmg file. A drive icon will appear on your Desktop Finder window. Double click on this to open.
2. Double click the Dante Controller .pkg. This will run the installer.
3. Read the license text, and if you accept the terms of the agreement, click Agree.

   If you do not accept these terms, click Disagree to terminate the installation.

   Note: Dante Updater will also be installed automatically.
Updating Dante Controller

Dante Controller can be updated directly from the application itself.

ℹ️ Note: Requires an active Internet connection.

Checking for Updates Manually

In Windows:
From the Help menu, select 'Check for Updates'.

In macOS:
From the Dante Controller application menu, select 'Check for Updates'.

Checking for Updates Automatically

Dante Controller can also check for updates automatically. If an update becomes available, you will be notified via a pop-up message.

To activate automatic checking, in the update dialog, select the option to check for updates automatically.

Uninstalling Dante Controller

You should not need to uninstall Dante Controller before installing a new version.
However, if you do wish to uninstall Dante Controller:

Windows

Navigate to Control Panel > Programs and Features, select Dante Controller and click Uninstall.

ℹ️ Note: Two other Dante features, 'Dante Control and Monitoring' and 'Dante Discovery', may still be present in the programs list after uninstalling Dante Controller. Do not uninstall these features if they are present - they are required by other Dante software applications (for example, Dante Virtual Soundcard, Dante Updater, and third-party Dante control applications). They will be removed automatically if they are no longer required.

macOS

Use the Uninstall tool available in the .dmg file.
Dante Basics

Discovery and auto-configuration

When a Dante-enabled device is connected to an IP/Ethernet network, it will automatically:

1. Configure its IP address
2. Advertise itself to allow automatic discovery

Within seconds of a Dante-enabled device connecting to a network, Dante Controller will automatically discover and display the device, allowing you to configure channels and route media.

Automatic network configuration

A Dante-enabled device connected to a network will automatically setup its own network configuration, including its IP address.

If the network has a DHCP server, which may be the case for installed networks, it will receive its IP configuration using the standard DHCP protocol.

On a network without a DHCP server, which may be the case for temporary or smaller networks, the Dante-enabled device will automatically assign itself an address using link local protocols, in the same way PCs and printers often do.

Automatic discovery

A Dante-enabled device will advertise information about itself to other Dante devices and Dante Controller, including:

- Device name
- Channel names
- Number of channels
- Sample rates and bit depths

This information can be seen when viewing a device on Dante Controller, and allows Dante devices to determine compatibility with other devices, such as compatible sample rates to allow media to be routed.

Device Channels

A Dante device has a number of channels associated with it. These are either transmit (Tx) or receive (Rx) channels. Receive channels and devices are listed down the left side of the grid. Transmit channels and devices are listed along the top of the grid.

Transmit channels are advertised on the network. A receiver uses this advertisement to establish a subscription to the channel. A transmit channel can be sent to multiple receivers using unicast or multicast.

Note: Ancillary channels on AV devices cannot be sent via multicast.
Receive channels are connected to transmit channels via a subscription. Each receive channel will receive media over the network from at most one transmit channel.

**Subscribing to Media Channels**

In the Routing View, a blue square at the intersection of an Rx and a Tx channel indicates that it is possible to create a media route between those channels. A grey square indicates that it is not possible to create a route between those channels. This may be because of a mismatch in sample rate between the transmitter and receiver, or because a device cannot route to itself.

When you click a blue square at the cross-point between a transmit channel and a receive channel, a subscription will be created, and a green tick will appear in the matrix cross point. You may initially see a grey hourglass icon (usually very briefly) to indicate that the subscription is in progress.

If there is a problem with the subscription, either a warning or an error icon may appear. If many devices have been subscribed at the same time, a yellow pending icon may appear temporarily.

Hover the mouse over subscription icons to see a related tooltip (see Subscription Tooltips).

**Note:** Subscriptions can also be created in the Device View. This is covered in the [Device View section](#).

**Note:** You cannot create new subscriptions to a [locked device](#); however, existing subscriptions can be removed and replaced.

**Subscribing to Multiple Media Channels at once**

To subscribe multiple channels at the same time, hold down the Ctrl key and click the [-] symbol at the top left corner of the intersection between the two devices. All possible channels will be subscribed at the same time (see the figure in [Expanding the Routing View](#)).

**Unsubscribing Media Channels**

To unsubscribe a media channel, click on the cross-point containing a subscription. The subscription icon will be removed and revert to a plain blue square.

**Subscription Status**

The symbol displayed at the intersection of the Tx channel and the Rx channel in the Routing View provides information on the status of the subscription or connection, as follows:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Status Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🕒</td>
<td>In progress</td>
</tr>
<tr>
<td>🎧</td>
<td>Subscribed</td>
</tr>
</tbody>
</table>

The subscription is in progress
Connection is established and fully functional
Warning

This may indicate that:

- The subscription is unresolved, possibly because the transmitting device is not visible on the network (for example, because it has been removed, or switched off); or:
- There is another connectivity issue in the physical network that is affecting a media signal

Error

An error has occurred - for example, there is insufficient bandwidth to establish the subscription

Pending

Device is part-way through setting up subscription. Most commonly seen when subscribing many channels at a time

Note: The status of a subscription can change after it has been initially established, due to changes in the network or changes in other devices.

Subscription Tooltips

Hovering the mouse over a subscription icon in the Routing tab displays a tooltip containing information about the subscription.

If there is no problem with the subscription, the tooltip will display the Rx channel and device name, plus the Tx channel and device name (for example, 'kick@Monitor-Console <- 01@Stagebox-2'), plus the subscription status, and for successful subscriptions, the subscription type (unicast / multicast).

Other messages are displayed if the subscription is in any other state.

Some common messages are:

- 'Incorrect channel format: source and destination channels do not match'
  The receiver and transmitter are set to different sample rates.
- 'Mismatched clock domains: The transmitter and receiver are not part of the same clock domain'
  One of the devices is configured with sample rate pull-up/down that does not match the other device.
- 'Tx Scheduler failure'
  This is typically because you are trying to use sub-millisecond latency over a 100 Mbps network link (1 msec is the minimum supported latency over 100 Mbps links).
- 'No Receive flows: receiver cannot support any more flows'
  Indicates the receiver is subscribed to too many devices (devices typically do not support the same number of flows as they do channels). See Routing Audio > Flows for more information.
'No more flows (TX): transmitter cannot support any more flows’  
Indicates that too many devices are subscribed via unicast to the transmitter. See Fanout for more information.

'Cannot change: Locked receiver.'  
Indicates a subscription from a locked receiver. Subscriptions from locked receivers cannot be changed.

'Warning: Locked transmitter.'  
Indicates that the transmitter is locked. You cannot create new subscriptions to a locked transmitter.

'Access control failure: Transmitter is locked.'  
Indicates a subscription that failed because the transmitter is locked.

Differentiating Between Input and Output Channels

Channels are classified according to whether they put data onto, or take data off the network:

- A channel that puts data onto the network is known as a transmitting, Tx or output channel.
- A channel that takes data off the network is known as a receiving, Rx or input channel.

Device and Channel Names

In Dante, devices and media channels are identified by names, not ‘magic numbers’. Device and channel names can be customized.

- Dante routing is performed using the Device and channel names. A receive channel can be subscribed to the name of a transmit channel at a device.

  Example: “Analog L@my-transmitter” describes a channel named “Analog L” on a device named “my-transmitter”. Device names must be unique on a Dante network. Channel names must be unique on the device.

- If a device or channel is renamed, Dante routing considers it to be a different device or channel. If a new device or channel is then given the old name, Dante routing will route from the new device in place of the previous device.

  Example: The power supply on “stage-box” fails and “stage-box” needs to be replaced. The old “stage-box” is removed, and a new box is plugged in and named “stage-box”. Dante receivers previously subscribed to the old “stage-box” will now automatically restore their subscriptions to the new “stage-box”.

- Device names must be unique on the network. If you attempt to rename a device using Dante Controller to a name that is already in use on the network, Dante Controller will notify you and reject the name change.

  Example: There is an existing device on the network called “MY16-slot1”. If user attempts to rename another device to “MY16-slot1” Dante Controller will notify you that the name is already in use. The device will not be renamed.

- If a new device is added to the network with a name that already exists, a name conflict is detected. One of the devices will adopt a temporary placeholder name, by appending a space and (2) to
its old name. This device will not be able to transmit media until it is manually renamed, and some configuration options will be disabled for that device in Dante Controller.

**Note:** A device that has been renamed with (2) appended (e.g. “MY16-slot1 (2)”) will not be able to transmit media until it is renamed. The device name must be changed by the user to be a valid non-conflicting name before the device can become fully functional. A device that has failed with a name conflict will retry its configured name if it is rebooted. If the other device has been removed or renamed, the previously failed device will resume normal operation.

### Rules for Names

- All Dante names are up to 31 characters in length.
- Name comparisons are case-insensitive: “Guitar” and “guitar” are treated as the same name.
- Unicode and non-roman characters are not supported.
- Device names should follow Domain Name System (DNS) hostname rules. Legal characters are A-Z, a-z, 0-9, and '-' (dash or hyphen).
- Device names cannot begin or end with a hyphen.
- Device names must be unique on the network.
- Tx channel names may use any character except '=' (equals), '.' (full stop or period), or '@' (at).
- Rx channel names follow the same rules as Tx channel names.

### Routing Media

#### Routing Terminology

- **Device:** A device means a Dante-enabled device, and more specifically that component of the equipment that implements the Dante interface. A Dante device typically has Tx and Rx channels and other routing-related properties.
- **Transmit (Tx) channel:** A transmit channel transmits media from the media hardware onto the network.
- **Receive (Rx) channel:** A receive channel receives media from the network and sends it to the media hardware.
- **Flow:** Dante media routing creates flows. Each flow carries several channels of audio, or one channel of video from a transmitter to one or more receivers. Unicast routing creates flows to single receivers. Multicast routing creates flows that can be received by multiple receivers. Multicast flows are assigned IDs enabling them to be identified in Dante Controller.
- **Unicast routing:** Unicast flows are point-to-point from a single transmitter to a single receiver. Unicast flows typically have room for 4 channels of audio or 1 channel of video.
- **Multicast routing:** Multicast flows are one-to-many from a single transmitter to any number of receivers. Use Dante Controller to choose which channels are to be multicast. Unlike unicast routing, multicast flows consume network bandwidth even if there are no receivers, but do not require additional bandwidth to add more receivers.
- Subscription: A subscription configures a receive channel to receive media from a transmit channel on another Dante device.

- Subscription status: For a receive channel, subscription status indicates whether it is subscribed, whether it is receiving unicast or multicast media, whether the subscription is OK, or whether an error has occurred.

**Subscription**

Dante routing is performed by associating a receiving (Rx) channel with a transmitting (Tx) channel. This is called 'subscription'.

**Example:** Route Tx channels 1 and 2 (named "Audio L" and "Audio R") on the device named "Source" to Rx channels 3 and 4 on the device named "Dest".

Rx channels 3 and 4 on "Dest" are subscribed as follows:

- 3. Audio L@Source
- 4. Audio R@Source

Dante will perform the necessary routing to deliver the media from the Tx channels to the Rx channels.

**Redundancy**

Many Dante devices support redundant media routing. These devices have two network interfaces, named primary and secondary. Primary interfaces should be connected to one physical network. If redundancy is being used, secondary interfaces should be connected to a second separate network. Secondary interfaces cannot communicate with primary interfaces.
If the secondary network is connected to a device that supports redundancy, it is enabled automatically. The same media data is transmitted on both the primary and secondary networks simultaneously. In the event of a failure on one network, media will continue to flow via the other network.

**Note:** Dante redundancy requires that both the primary and secondary interfaces on any redundant device are connected using the same link speed. For example, if the primary interface is connected to a 1 Gbps switch port, the secondary interface must also be connected to a 1 Gbps switch port. Similarly, if the primary interface is connected to a 100 Mbps switch port, the secondary interface must also be connected to a 100 Mbps switch port.

**Note:** Dante devices that do not support redundancy must be connected to the primary network only.

### Media Formats

Most Dante devices support a range of media formats (audio sample rates, or video resolutions). Devices can usually be switched between media formats, but will not support more than one at a time. It is only possible to set up a subscription between channels which have a common media format. Channels on devices with incompatible formats will be shown in grey, and will not be routable.

### Flows

Dante media routing creates 'flows'. Each flow carries one or more channels of audio, or one channel of video from a transmitting device to one or more receiving devices. There are two types of flow, unicast and multicast.

Unicast routing creates flows to a single receiving device; a unicast flow typically assigns space for 4 channels of audio, or 1 channel of video. Unicast flows are set up when a receiver subscribes to an available media channel, and are automatically removed when the receiver unsubscribes from all channels in that flow.

Multicast routing creates flows that can be received by multiple receivers. Multicast flows are assigned IDs, enabling them to be identified in Dante Controller, and to facilitate their removal. In contrast to unicast flows, multicast flows must be set up on the *transmitting* Dante device before receivers can subscribe to these flows.

### Advanced Routing: Using Multicast

Dante routing is unicast by default. This means that a separate flow is set up between each transmitter and receiver. If several receivers are all subscribed to the same channels of a transmitter, it may sometimes be more efficient to use multicast.

Multicast sends the same set of channels to multiple receivers. In practice, this usually means that the flow is flooded throughout the network. If many receivers want the same channels, using multicast can reduce overall network use, especially on the transmitter, because only one copy of each channel needs to be sent, rather than many.

Dante receivers will automatically prefer multicast to unicast if it is available. This means that if a new multicast flow is created containing the channels that a receiver is currently receiving as unicast, the receiver will switch over to receiving media from the multicast flow and the unicast flow will be removed.
Routing for Video Devices

Video (Dante AV) devices support three major channel types.

Audio Channels
Audio channels are represented in Dante Controller by the following icon:

Audio channels for Dante video devices are treated and managed identically to audio channels for audio-only Dante devices.

Video Channels
Video channels are represented by the following icon:

Video channels contain packetised video data streams, and can be routed in the same way as audio channels. However, they typically use more bandwidth than audio channels, and require 1Gbps (or higher) switch ports.

Note: IGMP snooping must be enabled on network switches that will be carrying Dante video on 1Gbps network infrastructure. Refer to your switch manufacturer's documentation for information about enabling IGMP snooping.

Ancillary Channels
Ancillary channels are represented by the following icon:

Ancillary channels are 'custom' channels, defined by the device manufacturer, to carry additional data (not audio or video) between devices. Typically they are used to carry hardware control data, such as USB peripheral or infrared transport control data.

Ancillary channels are typically low bandwidth (compared to audio and video channels).
Some ancillary channel types cannot be added to multicast transmit flows.
A typical Network view for a network that includes video devices (with four types of ancillary channels) is shown below.

In this example:

- The 'Video Rx' channel on the AV-Display-FOH receiver is subscribed to the 'Video Tx' channel on the AV-Mixer transmitter.
  This subscription would cause video from the AV mixer to be displayed on the front of house display screen.
- The '01' and '02' audio channels on the Amp-FOH1 audio receiver are subscribed to the 'Left' and 'Right' Tx channels on the AV-Mixer transmitter.
  These subscriptions would cause the left and right audio channels from the AV mixer to be played out via the front of house amplifier.
- The 'USB' and 'IR' ancillary channels on the AV-Display-FOH receiver are subscribed to the equivalent channels on the AV-Mixer transmitter.
  These subscriptions would enable USB peripheral (for example, mouse and keyboard) and infrared control of the transmitter via the control ports on the receiver.
Note that control data on some types of ancillary channel (somewhat counter-intuitively) may actually flow from the receiver to the transmitter. This enables transmitting video sources to be controlled remotely at the receiver. For example, you could start and stop a Blu-Ray player (a transmitter) in another room using an infrared remote control pointed at the screen that is actually playing the video (a receiver).
Clock Synchronization

In Standard Dante Networks

All Dante-enabled devices use the IEEE 1588 Precision Time Protocol (PTP) across the network to synchronize their local clocks to a leader clock, providing sample-accurate time alignment throughout the network.

One Dante device will be elected as the PTP Leader Clock for the network; all other Dante devices act as a PTP Follower Clocks to the elected leader clock. Although many Dante devices may be capable of becoming PTP Leader Clock, only one device will win the election. Devices with clock inputs (e.g. Word Clock or AES3) will be preferred in the election process. A gigabit connected device is preferred over a device connected via 100Mbps. A tie-breaker rule of the lowest MAC address is used if several equivalent candidate leader clocks are available. The election process may be overridden by manually setting 'Preferred Leader' on a device.

Dante Clock Types

Each Dante hardware device can derive its clock from either its high-quality onboard clock circuit, or an externally connected word clock. In the case of Dante Virtual Soundcard, the computer's clock will be used.

Clock Settings

Enable Sync To External

A Dante device set to 'Enable Sync To External' will use the external word clock from its host equipment to tune its onboard VCXO. A Dante device with this attribute set will become the PTP Leader Clock, unless there is another Dante device present with 'Preferred Leader' set.

Preferred Leader

Sometimes it may be necessary to force a particular device to provide the PTP Leader Clock. A Dante device with 'Preferred Leader' set will always be chosen as the PTP Leader Clock. If more than one device has 'Preferred Leader' set, the device with the lowest MAC address will be chosen.

Note: If device A is deriving its clock from an external word clock source ('Enable Sync To External'), but device B is set as Preferred Leader, device A will lose sync with the Dante network and will eventually be muted - unless device B is also deriving its clock from the same external source as device A.

Clocking Status

Clocking and Synchronization in Redundant Networks

In a redundant network, the clock synchronization protocol operates over both primary and secondary networks. Each network will have a designated PTP leader clock; usually this will be the same device on both networks. If this is not the case (e.g. if a non-redundant device is designated Preferred Leader) then one device will bridge the clock synchronization information from the primary to the secondary network, ensuring that all devices derive their clock from the same source. Redundant PTP Follower clocks will synchronize their local clocks based on information from one of the networks they are
connected to. In event of a failure on one network, a redundant device will continue to receive clock synchronization information over the other network.

### In Dante Domains

In Dante domains, there is one Primary Leader clock, and if the domain spans IP subnets, an additional 'subnet leader' clock for each subnet, plus one or more boundary clocks for each subnet. The subnet leader may also be a boundary clock for its own subnet.

Boundary clocks use PTP v2 (IEEE 1588-2008) for unicast clocking between subnets. Boundary clocks can be manually or automatically specified using the DDM web interface.

Each Dante domain will use its own individual clock domain, unless media sharing between domains is configured, in which case all domains in the shared media group share the same clock domain.

### Latency

#### For Audio Devices

For Dante audio devices, variation in latency in the network is compensated for at the receiver. Each receiver has a device latency setting. This setting defines the latency between the timestamps on the incoming audio samples and when those samples are played out.

The typical default latency for a Dante audio device is 1 msec. This is sufficient for a very large network, consisting of a Gigabit network core (with up to 10 hops between edge switches) and 100 megabit links to Dante devices. Smaller, Gigabit-only networks can use lower values of latency (down to 150 µsec for very fast devices, such as PCIe cards). Recommended latency settings are displayed in Dante Controller, and may also be found in the documentation accompanying the product.

Latency is set on the receiver. However, when a subscription is made, there is an automatic negotiation process between the receiver and the transmitter, to ensure that the latency for the subscription is high enough to prevent packet loss.

For example, Ultimo devices support a minimum of 1ms latency. If a faster device (such as a PCIe card) is set to 0.25ms latency, and is then subscribed to an Ultimo transmitter, the latency used for the subscription will be 1ms, which is the minimum supported latency for the subscription. Subscriptions to other devices (such as a Brooklyn II device) will be set at 1ms (or whatever latency the receiver is set to). This effectively makes the device latency setting a 'default' latency, which is used unless the transmitter doesn't support it.

**Note:** The minimum latency available for a device connected to a 100 Mbps network port is 1 msec.

Using a latency lower than 1 msec over a 100 Mbps link will result in a subscription error, with the `tooltip` 'Tx Scheduler Failure'.

#### Latency Monitoring

Dante Controller provides latency monitoring for supported devices. For more information, see [Latency Tab](#).
**Latency and Dante Virtual Soundcard**

Dante Virtual Soundcard allows a standard Apple Mac or Windows PC to function as a Dante device. Because Dante Virtual Soundcard runs on a general purpose computer without special hardware to support Dante timing requirements, additional latency needs to be added to connections received from a Dante Virtual Soundcard transmitter.

Dante Virtual Soundcard is configured with custom latency values for reliable operation. Dante devices with Rx channels that are subscribed to Tx channels from a Dante Virtual Soundcard transmitter will automatically configure themselves to use these higher latency values for those channels only. The latency on all other subscriptions on the receiver is unaffected.

**Latency in DDM Networks**

Devices that are enrolled in a Dante domain may support extra latency values, to accommodate larger network topologies.

If a device is un-enrolled while it is set to one of these latency values, its latency will be automatically reset to the default value for the device.

**For Video Devices**

For video (Dante AV) devices, the Device Latency setting in Dante Controller applies to the audio channels only.

**Device Lock**

Device Lock allows you to lock and unlock supported Dante devices using a 4-digit PIN (Personal Identification Number).

When a device is locked, media will continue to flow according to its existing subscriptions, and it can be monitored, but it cannot be controlled or configured - its subscriptions and configuration settings become read-only.

To configure a locked device you must first unlock it using the PIN with which it was locked.

Locked devices can be identified by:

- A small gray padlock icon against the device name in the Network View > Routing tab
- A red background highlight when the device is moused over in the Network View > Routing tab
- A check (tick) in the Device Lock column in the Network View > Device Info tab
- A red padlock icon in the Device View toolbar

Not all Dante devices support Device Lock.

To check if a Dante device can be locked:

- Use the Advanced Filter to check for locked, unlocked and unsupported devices
- Check the Device Info tab - devices that support Device Lock have a checkbox in the Device Lock column; devices that do not support Device Lock show ‘N/A’ in the Device Lock column
- Open the device in Device View - if the padlock icon in the toolbar is blue or red, the device supports device lock; if it is grayed out, it does not support Device Lock
- If in doubt, contact the device manufacturer
Locking a Dante device

To lock an unlocked Dante device:

Using Device View

1. Open the device in Device View (Ctrl + D, or Command + D) and click the padlock icon. The Lock Device panel is displayed.
2. In the Lock Device panel, enter a 4-digit PIN in the PIN field.
3. Enter the same PIN in the Confirm PIN field.
4. Click ‘Lock’.

The padlock icon will change to red indicating that the device is now locked.

From the Device Info Tab

1. In Network View, select the Device Info tab.
2. Click the Device Lock checkbox for the device.
3. Follow steps 2-4 from the above process.

Unlocking a Dante Device

To unlock a locked Dante device:

Using Device View

1. Open the device in Device View (Ctrl + D, or Command + D) and click the padlock icon.
2. In the Unlock Device panel, enter the 4-digit PIN in the PIN field.
3. Click Unlock.

The padlock icon will change to blue indicating that the device is now unlocked.

From the Device Info Tab

1. In Network View, select the Device Info tab.
2. Click the Device Lock checkbox for the device.
3. Follow steps 2-3 from the above process.

Unlocking a Device When You Have Forgotten the PIN

If you have forgotten the PIN for a locked device, you can reset the PIN.

To reset the PIN for a locked device:

1. Isolate the device from the rest of the Dante network.
2. Disconnect and reconnect the device.
3. Wait for at least 2 minutes.
4. Use the ‘Forgot PIN’ option in the Unlock Device panel.

How to Isolate a Device from the Rest of the Dante Network
There are 3 ways to isolate a device from the rest of the network.

Option 1: Remove all other Dante devices from the Dante network
You can isolate a device by physically disconnecting all other Dante devices from the network switch, or by completely powering down all other devices, leaving on the network only the locked device and the computer running Dante Controller.

Note: Dante Virtual Soundcard and Dante Via are considered to be Dante devices - all running instances of those applications must be fully stopped, even if they are on the same computer on which you are running Dante Controller.

Option 2: Connect your Dante Controller computer directly to the device
Physically remove the device from the main Dante network switch, and either connect it directly to your Dante Controller computer (using a normal Ethernet cable), or connect the device and your computer to a separate network switch (to which there are no other Dante devices connected).

Option 3: Use a VLAN
Set up a Virtual Local Area Network on which there are only the locked device, and the Dante Controller computer.

Resetting the PIN for a Locked, Isolated Device
Once you have isolated the locked device, disconnected and reconnected it, and then waited for at least 2 minutes:
1. Open the Unlock Device panel for the device (See Unlocking a Dante Device).
2. Click the ‘Forgot PIN’ option.
3. Click Reset.

The device is now unlocked, and can be re-locked using a new PIN if required.

Subscriptions from Unlocked Devices to Locked Devices
If there are existing subscriptions to a device when it is locked, those subscriptions will continue to function as normal.
They can also be removed, and replaced (assuming the subscribing device is unlocked).
No new subscriptions can be made to a locked transmitter. The ‘Access control’ tooltips are associated with attempted subscriptions to locked transmitters.

Note: If you attempt to subscribe a legacy (pre-v3.10 firmware) receiver to a locked transmitter, subscription status icons for any existing subscriptions (made before the device was locked) may change to indicate an error state. However, audio will continue to flow for those subscriptions. To reset the subscription icons: Remove all subscriptions, and reinstate the original subscriptions only.
Locking Devices with Residual Connections

Occasionally, a transmitter will have residual unused connections (transmitting but unsubscribed channels) from a previous subscription state, which need to be closed before the device is locked. This can cause an interruption to media from that device.

When you attempt to lock a device and residual connections are detected, Dante Controller presents a warning dialog:

Click Ok to proceed or Cancel to abort the lock process.

While the residual connections are being closed, Dante Controller displays a progress dialog:

When the preparation process is finished, the standard Lock Device dialog is presented, and the device can be locked as normal.

Dante Control and Monitoring

In addition to automatic configuration and discovery, media transport and routing, Dante-enabled devices can also be controlled and monitored in various ways. This includes being able to view and change specific parameters, such as clock configuration settings. Dante devices are also capable of sending status events that can be viewed using Dante Controller. Status events include changes in clock status, or network interface changes.

**Note:** The computer service that manages control and monitoring is called 'ConMon' or 'Dante Control and Monitoring'.
Starting Dante Controller

Where to find the Dante Controller application

**Windows**

By default Dante Controller will be installed in
C:\Program Files (x86)\Audinate\Dante Controller\n
It can be started in several ways:
- Using the Start menu: Start > Audinate > Dante Controller > Dante Controller
- Run by going to Start > Run and entering
  C:\Program Files\Audinate\Dante Controller\DanteController.exe
  in the dialog box
- Navigate to the directory where it is installed, and double-click the Dante Controller icon:

**macOS**

The Dante Controller application will be installed in the Applications folder.

To start:
- Navigate to Applications folder, and double-click the Dante Controller icon:

Or:
- Drag the icon to the Dock and click on it

Configuring Dante Controller

**Network Interface Selection**

Dante Controller can communicate with other Dante devices on the primary network, or the secondary network, or both. Dante Controller needs to know which of the network interfaces of the host computer is connected to each physical Dante network.

Dante Controller supports connection to Dante networks via Ethernet and Wi-Fi network interfaces.

The first time Dante Controller is run, you may be presented with the Configure Dante Interfaces dialog (shown below). Use this dialog to select the primary and secondary Dante interfaces. Once interfaces have been selected, they are remembered for future use, and this dialog will not be shown when Dante Controller is run subsequently.
Note: In DDM networks, Dante Controller may use a different interface to connect with Dante devices.

Note: When connecting a network interface on your computer to a secondary Dante network with no DHCP server, the network interface should be configured with a static IP address in the 172.31.*.* range, with a subnet mask of 255.255.0.0.

The icons displayed indicate the selected interface type and status:

- Operational 1Gbps Ethernet interface
- Operational 100Mbps Ethernet interface
- Disabled / disconnected Ethernet interface, or no interface selected
- Operational Wi-Fi interface
- Wi-Fi interface selected with no Wi-Fi network connection
To display this dialog at any other time, click the button in the main toolbar.

**Use Shared Dante Interface**

With this option selected, the selected primary network interface will be automatically used by other Audinate software applications installed on that computer (including Dante Via, Dante Virtual Soundcard and Dante Updater) when they are started. This helps to ensure that all Audinate applications are connected to the same Dante network.

Only wired Ethernet network interfaces are supported in this mode.

With ‘Use shared Dante interface’ deselected, Dante Controller is able to connect to any available Ethernet or Wi-Fi network interface, and the selection is fully independent of any other Audinate software applications.

**Wi-Fi Network Connections**

To connect to a Dante network via Wi-Fi, a Wi-Fi access point must be present and enabled on the Dante network - for example, a Wi-Fi router physically connected to a network switch or Dante device in the Dante network.

*Note:* Dante audio and video transmission over Wi-Fi is not supported.

To connect to a Dante network using Wi-Fi:

1. Ensure your Wi-Fi interface is successfully connected to a Wi-Fi network.
2. Ensure ‘Use shared Dante interface’ is deselected.
3. Select your Wi-Fi network interface in the Configure Dante Interfaces dialog.

See also: Using Wi-Fi and Multicast Transmit Flows

---

**Network Interface Configuration Guidelines**

**Primary only (non-redundant) Dante network**

If you only have a primary network, you can only connect one interface to the Dante network.

*Example*

In the example below, the laptop (running Dante Controller) and the two Dante devices are connected to the switch via their primary interfaces. This is a typical non-redundant Dante network.

If the laptop has two network interfaces, either can be used.
Primary and secondary Dante networks (redundant configuration), only one network interface on the host computer

If you have primary and secondary (redundant) networks, but only one network interface on your computer, you should set your computer's network interface as the primary interface. This ensures that you can control any non-redundant devices, and see full connection information for any redundant devices that are connected to non-redundant devices.

If a problem does occur, and you lose connectivity on the primary network, you can connect instead to the secondary network, to maintain control over your devices. This entails changing the physical connection (i.e. physically connecting your computer to a switch on the secondary network), and changing the interface selection in the Configure Dante Interfaces dialog.

Example

In the example below, the laptop (running Dante Controller) is connected to the switch via one interface only, which is set as the primary Dante interface.

The two Dante devices are connected to the primary switch via their primary interfaces, and to the secondary switch via their secondary interfaces. The two switches are not connected to each other. This is a typical redundant network configuration for computers with only one network interface.
Note: When connected to the secondary network, you will not have control over devices that are only connected to the primary network (i.e. non-redundant devices, or Dante Virtual Soundcard). You will see the device names in the Network view, and in subscription dialogs (for example, the Device View > Receive and Transmit tabs) but you will not be able to view or edit device configuration for those devices. Also, if the leader clock is only connected to the primary network, its name will not resolve in the 'Leader Clocks' section of the main window tool bar, it will be shown as a MAC address string.

Primary and secondary networks (redundant configuration), two network interfaces on the host computer
If you have primary and secondary networks, and two network interfaces available on the host computer, you should connect one interface to each network. This means that you will always have full control of all redundant devices, even if the primary network fails.

Example
In the example below, the laptop (running Dante Controller) and the two Dante devices are connected to the primary switch via their primary interfaces, and to the secondary switch via their secondary interfaces. The two switches are not connected to each other. This is a typical redundant network configuration for computers with two (or more) network interfaces.
**Note:** All Dante applications on the same computer have a shared understanding of which interface is the primary Dante interface. For example, if you have installed Dante Virtual Soundcard on the same computer as Dante Controller, and a new primary interface is selected from within Dante Virtual Soundcard, Dante Controller will automatically switch to the newly selected interface, and begin operating on that interface.

**Connection via Wi-Fi**

To connect to a Dante network via Wi-Fi, a Wi-Fi access point must be physically connected to the Dante network (either to a network switch, or to a Dante hardware device). The Wi-Fi interface on the Dante Controller computer must be connected to the Wi-Fi access point.

**Example**

In the example below, the computer running Dante Controller is connected via Wi-Fi to a Wi-Fi access point connected to the primary Dante network.
Using Wi-Fi and Multicast Transmit Flows

When using a Wi-Fi network connection between Dante Controller and your Dante network, any multicast transmit flows configured in your network routing can flood the Wi-Fi link, and degrade the performance of the link.

You may be experiencing this condition if:

1. You are using a Wi-Fi network connection
2. You have multicast transmit flows in place
3. You observe speed or stability issues with your Wi-Fi connection

Remedial action

Remove or reduce the multicast traffic

The easiest way to remedy this condition is to either remove all multicast flows and use unicast flows instead; or, reduce the amount of multicast bandwidth on the network by removing some multicast flows.

There is no hard rule that specifies how much multicast traffic is too much for a Wi-Fi link - the performance of the link is the best real-world indicator.

If you are unable to remove or reduce multicast traffic, there are various ways to filter multicast media traffic from the Wi-Fi link.

Filter multicast media at the access point

Depending on the type of Wi-Fi access point (or AP - typically, a W-Fi modem / router) that you have, it may automatically block ‘unregistered’ multicast traffic, which is multicast traffic that hasn’t been specifically requested by a network device. Because Dante Controller will never request to join a multicast media stream, the AP will never send multicast media traffic (audio or video) to the Dante Controller computer.
It should however allow multicast control traffic - this is important for Dante Controller, because device discovery in Dante uses a multicast control protocol.

If the AP doesn’t automatically block unregistered multicast, you may be able to proactively filter it out using a ‘filter multicast’ feature in the AP. The feature should filter the high-bandwidth multicast media traffic, but again should allow multicast control traffic. Not all APs feature automatic multicast filtering, or a ‘filter multicast’ configuration option. Refer to the user manual for your AP for more information.

Connect the AP to a dedicated control port on a Dante device

Some Dante hardware devices include a ‘control port’, which is a Dante Ethernet port that automatically filters multicast media traffic. Control ports should be clearly marked as such on the device.

You can connect your AP to this port, which will enable Wi-Fi connectivity between Dante Controller and the network, but the port will not pass multicast media traffic to the AP. Refer to the user manual for your device for more information.

Enable IGMP snooping on the network switch

Enabling IGMP snooping on the network switch will block multicast media to all switch ports unless a device on that port has specifically requested to join a multicast group (stream). This means that multicast media can flow between audio and video devices but will not flow over the AP to Dante Controller. Refer to the user manual for your switch for more information.
Using Dante Controller

Dante Controller presents two main types of view: **Network View** and **Device View**.

**Important:** After making changes to Dante network routing (e.g. subscriptions, device names, channel names etc.) please wait at least 5 seconds before disconnecting or powering down any affected devices. This ensures that the new information has been properly saved to the devices. Device configuration (e.g. sample rates, latency, clock settings) are saved instantly.

**Note:** macOS users: Please note that the key combinations shown below are for Windows users. When using Dante Controller on a Mac, use the “Command (CMD)” or “Apple” key instead of the “Control” key when following the instructions below, and substitute standard Mac key combinations where applicable - see the Dante Controller menu for details.

**Network View**

When Dante Controller is started, it opens at the Network View, with the Routing tab selected.
**Note:** For networks that include video (Dante AV) devices, see Routing for Video Devices

### Menu bar

The menu bar in the Network View includes four menus: **File**, **Device**, **View** and **Help**.

**File**
- **Load Preset** (Ctrl+L): loads a configuration from a file
- **Save Preset** (Ctrl+S): saves configuration for currently displayed devices to a file
- Interfaces: Opens the Configure Dante Interfaces dialog
- Exit (Alt+F4): Exits Dante Controller

See [Presets](#) for more information.

**Devices**
- Refresh (F5): Refreshes the displayed network / device data
- Clock Monitoring: Toggles clock monitoring on/off
- Connect Devices to DDM / Dante Cloud
- Device View (Ctrl+D): Opens a new Device View window

**View**
- **Dante Updater** (Ctrl + U)
- **Dante Activator** (Ctrl + I)
- **DDM / Dante Cloud Login** (Ctrl + O)
- **Language**: Select the user interface language. Set to ‘Auto’ to use the default operating system language.
- **Show Filter Pane** (Ctrl + Shift + F)
- **Show/Hide Channel Groups** (Ctrl + Shift + G)
- **Show Hidden Devices** (Ctrl + E)

**Help**
- **About**: Shows the Dante Controller version, and current event log file location
- **Show License**: Displays the license text
- **Check for updates**: Checks the update server for new Dante Controller versions
- **Analytics**: Disable / enable analytics data collection
- **Feedback**: Opens your default browser at the Audinate Product Feedback form
- **Online Help (F1)**: Opens this HTML user guide on the Audinate web server (requires an Internet connection)
- **Offline Help**: Opens a locally-stored PDF of this user guide (may not be the latest version of the user guide)

**Tool bar**

Below the menu bar there is a tool bar, containing these buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Filter pane" /></td>
<td>Shows / hides the advanced filter pane.</td>
</tr>
<tr>
<td><img src="image" alt="Reload Device Information" /></td>
<td>Updates the current view with the latest device information from the network. This is useful when a recent change to the network has not yet propagated automatically through to Dante Controller (for example, a new device has been added to the network).</td>
</tr>
<tr>
<td><img src="image" alt="Load Preset" /></td>
<td>Loads a previously saved media routing configuration. See Presets for more information.</td>
</tr>
<tr>
<td><img src="image" alt="Save Preset" /></td>
<td>Saves the current media routing configuration. See Presets for more information.</td>
</tr>
<tr>
<td><img src="image" alt="Choose a Dante Interface" /></td>
<td>Opens the Configure Dante Interfaces dialog. See Configuring Dante Controller for more information.</td>
</tr>
</tbody>
</table>
Clock Monitoring
Activates the Clock Status Monitoring function. See Clock Status Monitoring for more information.

Channel Groups
Activates channel groups. See Channel Groups for more information.

Dante Updater
Launches Dante Updater.

Dante Activator
Launches Dante Activator.

Domain Manager Login
Enables connection to a Dante Domain Manager server.

To the right of the toolbar, Dante Controller displays the current Primary Leader clock (or clocks, in the case of redundant networks or DDM networks).

To the right of the clock display is the currently-selected domain, and the currently logged in DDM user (when logged into Dante Domain Manager).

Tabs
Click the tabs below the tool bar to view:
- Routing
- Device Info
- Clock Status
- Network Status
- Events

The use of each of these tabs is described in the next section.

Status Bar
The Status Bar displays notifications for network status, general device events, and clock status events, plus the current Dante media multicast bandwidth on the network.

DDM Networks
In DDM networks, the devices displayed in the Network View will vary according to the selected domain. See Viewing Domains in Dante Controller for more information.

When logged into a domain that includes legacy (pre-v4.0 firmware) devices, those devices are displayed with gray highlighting instead of blue.

Shared devices are displayed with green highlighting and green text. See the DDM user guide for more information about sharing audio in DDM networks.
Status Bar

The Status Bar displays the following information:

- **P**: The current status of the Primary network. Green indicates that Dante Controller is currently connected to the primary Dante network. Red indicates a problem with the connection.
- **S**: The current status of the Secondary Dante network. Only displayed where a secondary network is connected.
- The number of discovered devices on the network
- **Audio Multicast Bandwidth**: The current Dante audio multicast bandwidth on the connected networks for unmanaged (un-enrolled) devices. Note that there may be network traffic from other sources that is not included in the multicast bandwidth reading.
- **Event Log**: Indicates the current status of the event log. Click the icon to open the Events View.
- **Clock Status Monitor**: Indicates the current status of the Clock Status Monitor. Click the icon to open the Clock Status Monitor.

Network View Tabs

Routing View

When Dante Controller is started, it always displays the Routing Tab within the Network View. In this view the network is shown in the form of a grid. Devices with Tx channels are displayed along the top row of the grid, and those with Rx channels are displayed along the left-hand column of the grid. Initially a collapsed view is presented; individual channels cannot be seen.

**Note**: If a device name is shown in red, it means Dante Controller has automatically detected an error condition. Double-click the device name to see more information. Refer to Automatic Notification of Device Errors for further explanation.

**Note**: If a device has Tx and Rx channels, it is shown both along the top row of the grid and also along the left-hand edge.
Expanding the Routing View

The Rx channels associated with any device can be displayed by clicking on the [+] to the left of the device name in the left-hand column of the grid. The Tx channels associated with any device can be displayed by clicking on the [+] above the device name on the top row of the grid. When this action is performed the grid view expands to show each channel of the device, and the [+] becomes a [-]. Clicking on [-] collapses the view. You can also group channels into sets of 16.

The Rx channels associated with all devices can be simultaneously expanded by clicking on the [+] of "[+] [-] Dante Receivers" at the top of the left-hand column. Similarly, the Tx channels associated with all devices can be simultaneously expanded by clicking on the [+] of "[+] [-] Dante Transmitters" at the left of the top row. Clicking on [-] will collapse the view.

Device List Filtering

The device lists in the Routing view can be filtered using the 'Filter Transmitters' and 'Filter Receivers' boxes, below the Dante logo in the top left-hand corner. Any text string typed into the box will filter the
view to only display devices that contain that text string, in either a device name, or channel name.

The filtering is case-insensitive. For example, in the Dante Controller Network view shown here, entering the string “foh” in either of the Filter fields would display only the FOH-Amp and FOH-Console devices, and their channels.

See also: Advanced Filter

Advanced Filter

About the Advanced Filter

The Advanced Filter can be used to filter the devices displayed in the Network View Routing, Device Info, Clock Status and Network Status tabs.

Use the Advanced Filter to easily locate or display devices with specific names, channel names, states or configuration parameters.

To open the advanced filter, click the sidebar button:

Filter groups (including the text filter) are additive (AND logic, not OR logic). The devices displayed are those that match all specified conditions. For example, entering ‘amp’ in the text filter and selecting ‘48k’ in the Sample Rate filter will display all devices with the ‘amp’ string in the device name (or receive channel names) which are also set to 48kHz sample rate.

Inside a filter group, selections use OR logic. For example, selecting ’44.1k’ and ‘48k’ in the Sample Rate filter will display all devices set to either of those sample rates.

Text Filter

The text filter displays devices with device names or receive channel names that match the text string entered into the Search field.

The device name filter is case-insensitive (capitalization is ignored), and allows alphanumeric characters (a-z, 0-9) and the hyphen character (-). Wildcards are not supported.

To clear the device name filter, just delete the text in the Search field, or click the Clear All button.
Device State and Configuration Filters

The device state and configuration filters can be expanded and collapsed using the plus [+ ] and minus [- ] icons.

- Device Lock
  - Locked
  - Unlocked
  - Unsupported

- Sample Rate
- Media Type
- Sync to External
- Latency
- Subscriptions
- Tx Multicast Flows
- AES67
- Sample Rate Pull-up

To filter devices for a particular condition or set of conditions, just select the required checkbox or combination of checkboxes.

Use the Clear All button to clear the selections from all filters.

Device Lock Filter

Use the Device Lock filter to display devices with a specific lock state.

- To display only locked devices, select the 'Locked' checkbox.
- To display only unlocked devices, select the 'Unlocked' checkbox.
- To display locked and unlocked devices, select both the 'Locked' and 'Unlocked' checkboxes.
- To display devices that do not support Device Lock, select the 'Unsupported' checkbox.

Sample Rate Filter

Use the Sample Rate filter to display devices with a specific sample rate setting.

- To display only devices with a particular sample rate, select the appropriate checkbox.
- To display only devices with one of a selection of sample rates, click the appropriate checkboxes.

Media Type Filter

Use the Media Type filter to display devices with specific channel types.

- To display only devices with video channels, select the 'Has Video Channels' checkbox.
- To display only devices with audio channels, select the 'Has Audio Channels' checkbox.
To display only devices with ancillary channels, select the 'Has Ancillary Channels' checkbox.
To display devices with a mix of channel types, select the appropriate checkboxes.

**Video Subtype**
Use the Video Subtype filter to display devices with the selected video format(s).

**Ancillary Type**
Use the Ancillary Type filter to display devices with specific ancillary channel types.
- To display only devices with USB channels, select the 'USB' checkbox.
- To display only devices with serial channels, select the 'Serial' checkbox.
- To display only devices with IR channels, select the 'IR' checkbox.
- To display devices with a mix of channel types, select the appropriate checkboxes.

**Sync to External**
Use the Sync to External filter to display devices with a specific Sync to External setting.
- To display only devices with Sync to External enabled, select the 'Enabled' checkbox.
- To display only devices with Sync to External disabled, select the 'Disabled' checkbox.
- To display devices with either setting, select the 'Enabled' and 'Disabled' checkboxes.
- To display devices that do not support Sync to External, select the 'Unsupported' checkbox.

**Latency**
Use the Latency filter to display devices with a specific latency setting.
- To display only devices with a particular latency, select the appropriate checkbox.
- To display only devices with one of a selection of latencies, click the appropriate checkboxes.

**Subscriptions**
Use the Subscriptions filter to display devices with a specific subscription state.
- To display only devices with no subscriptions, click the 'None' checkbox.
- To display only devices with one or more successful subscriptions, click the 'Has Successes' checkbox.
- To display only devices with subscription warnings, click the 'Has Warnings' checkbox.
- To display only devices with subscription errors, click the 'Has Errors' checkbox.

Note: ‘Success’ will not only display devices with only successful subscriptions — it will also display devices with a mix of successful and failed subscriptions. Similarly, ‘Failure’ will also display devices with a mix of failed and successful subscriptions.

**Tx Multicast Flows**
Use the Tx Multicast Flows filter to display only devices with Tx Multicast Flows configured.
- To display only devices with one or more Tx Multicast Flows configured, select the 'Active' checkbox.

**AES67**
Use the AES67 filter to display devices with a specific AES67 setting.
- To display devices with AES67 enabled, select the 'Enabled' checkbox.
- To display devices with AES67 disabled, select the 'Disabled' checkbox.
- To display devices with either setting, select the Enabled and Disabled checkboxes.
- To display devices that do not support AES67, select the 'Unsupported' checkbox.

**Sample Rate Pull-up**

Use the Sample Rate filter to display devices with a specific sample rate pull-up setting.
- To display only devices with a particular pull-up, select the appropriate checkbox.
- To display only devices with one of a selection of pull-ups, click the appropriate checkboxes.

**Channel Groups**

When Channel Groups is active, device channels in the Network View Routing tab are grouped into sets.

This makes it easier to view and make channel subscriptions for devices with large numbers of channels, such as PCIe cards.

To activate it, click the Channel Groups button in the Network view toolbar:

By default, the groups are named 1..16, 17..32 etc. - however, some devices may use custom grouping configurations.

To expand a channel group, click the plus [+ ] icon. To collapse a channel group, click the minus [- ] icon.
Note: Grouping channels does not affect routing or device behaviour.

Device Info

The Device Info tab provides a network-wide overview of device configuration and operating information. For DDM networks, devices are grouped into their respective IP subnets.

The tabular view presents the following information, in columns from the left:

- **Device Name**: The device name currently associated with the device
- **Model Name**: The model name of the device
- **Product Version**: The product version assigned by the manufacturer
- **Dante Version**: The firmware version for hardware devices, or software version for Dante software applications
- **Device Lock**: The lock state of the device. You can also click this field to open the device lock / unlock dialog.
- **Product Version**: The product version, as defined by the manufacturer
- **Primary Address**: The IP address assigned to the primary interface. IP addresses are currently assigned via DHCP, or automatically self-assigned. Self-assigned addresses on the primary interface will be in the 169.254.**.** range.
- **Primary Link Speed**: The Ethernet link speed of the primary interface
- **Secondary Address**: The IP address assigned to the secondary interface. Self-assigned addresses on the secondary interface will be in the 172.31.**.** range. 'N/A' indicates that the device does not support a secondary interface. 'Link down' indicates that the device supports a secondary Dante interface, but it is not currently connected.
- **Secondary Link Speed**: The Ethernet link speed of the secondary interface. Other values are possible (as per Secondary Address)

Note: A Dante interface may have a preferred link speed. Where it does, and an interface is not operating at that preferred link speed, the values in the Link Speed columns will be shown in red.
**Note:** If no device information is displayed for a device, it can indicate a ConMon (Dante control and monitoring service) failure on the device. The device may need to be reset or restored.

### Clock Status

The Clock Status tab provides a network-wide overview of the clocking state within the network. This view provides a convenient way of quickly scanning the network for clock information. For DDM networks, devices are grouped into their respective IP subnets.

The tabular view presents the following information, in columns from the left:

**Device Name**

The device name currently associated with the device.

**Sync**

Indicates the clock sync status for the device.

- A green light indicates that the device is currently synced to (or is driving) the network clock
- A red light indicates that the device is not currently synced

**Mute**

Indicates the mute status for the device.

- A red mute icon indicates that the device is currently muted (usually due to loss of clock sync)
- No icon in the mute column means that the device is not muted (audio should be flowing normally)

**Clock Source**

Indicates the clock source for the device.

- **Dante:** The device is deriving its clock from the Dante network, or is acting as leader clock (but not deriving its clock from an external source)
- **External:** The device is deriving its clock from an external word clock source

**Domain Status (DDM networks only)**

Indicates the clock's role for its domain.

- **Leader:** The device is the leader clock for the domain.
- **Follower:** The device is a boundary clock follower (receiving unicast PTP from a domain leader in a different subnet).
- **Standby:** The device is a backup boundary clock.

- **Disabled:** The device does not currently have a domain clocking role.

- **N/A:** The device cannot act as a boundary clock.

See the DDM user guide for more information about domain clocking.

### Primary v1 Multicast

Indicates the state of the PTP v1 (Dante audio) clock for the primary interface. Routed DDM networks will indicate a leader clock for each IP subnet.

- **Leader:** Device is the current PTP v1 Leader Clock on the primary Dante network

- **Follower:** Device is a PTP v1 Follower on the primary Dante network

- **Passive:** Device is not using clock synchronization information from this interface

- **Link Down:** The interface is not connected to the network

- **N/A:** Indicates that the device does not support clock status reporting. In the Secondary Status column, can also indicate that the device is non-redundant.

- **Listening:** Usually transient. When persistent, it indicates that the device can not operate as a clock leader (follower only), and is waiting for a clock leader to appear on the network.

Devices that are configured with sample rate pull-up/down are shown with the relevant pull-up/down value against their Clock Status. For example, a device acting as leader clock with +0.1% pull-up will be shown as **Leader (+0.1%)**. See [About Clock Domains](#) for more information.

Other transient clock states exist, which are not listed above.

### Primary v2 Multicast

Indicates the state of the PTP v2 clock for the primary interface, for AES67 or SMPTE-enabled devices. Possible states are identical to those for Primary v1 Multicast.

### Secondary v1 Multicast

Indicates the state of the PTP v1 (Dante audio) clock for the secondary interface. Possible states are identical to those for Primary v1 Multicast.

### Secondary v1 Multicast

Indicates the state of the PTP v2 clock for the secondary interface, for AES67 or SMPTE-enabled devices. Possible states are identical to those for Primary v1 Multicast.

### Preferred Leader

Raises the priority of the device in the leader clock election.

If only one device on a particular clock domain has this checkbox ticked, it ensures that the selected device becomes leader clock (for that clock domain). When multiple devices have their Preferred Leader checkbox ticked, the leader will be elected automatically from within that group.

If 'Follower Only' is shown instead of a checkbox, it indicates that the device is not capable of acting as a leader clock.

### Enable Sync To External

Forces the Dante module to derive its clock from an external source - either from a host device word clock, or from an auxiliary device.

This will also ensure that this Dante device becomes leader clock for the relevant clock domain (unless another device has 'Preferred Leader’ selected). It is not normal practice to configure more than one
device per clock domain with an external clock source. In this case, the user is assumed to have synthesized external word clock sources (e.g. house clock).

Where the checkbox is present but greyed-out (and inactive), it means that the Dante device can be follower to an external word clock, but it cannot be set directly from Dante Controller - it must be done via the host device user interface, or via some other method (e.g. third-party control software). If the checkbox is greyed out and populated, it means that the Dante device is currently following the external clock.

If N/A is displayed, it means that the device does not support slaving to an external word clock.

**Note:** If no clock status information is displayed for a particular device, it can indicate a ConMon (Dante control and monitoring service) failure on the device. The device may need to be reset or restored.

### About Clock Domains

Dante Devices that are *not* configured with sample rate pull-up/down operate on the default clock domain, using the default clock. Devices that *are* configured with sample rate pull-up/down operate on separate 'clock domains', which have their own dedicated PTP clocks, adjusted to account for the pulled up/down sample rates.

Clock domains are not physically separated, they all exist on the network simultaneously. Devices with pull-up/down synchronize to the appropriate clock for their pull-up/down setting, and ignore other clocks. Those devices are shown with the relevant pull-up/down value against their Clock Status in the Clock Status tab.

Dante devices can only transmit media to, and receive media from other devices on the same clock domain. For example, a device with zero sample rate pull-up/down operates on the default clock domain, and cannot transmit media to, or receive media from any devices on the +4.1667% clock domain, or the -1% clock domain, etc.

Up to 5 separate clock domains can be supported at any one time. All clock domains have their own leader clock.

### In DDM Networks

In DDM networks, each Dante domain typically uses its own special clocking domain (except in the case of media sharing between domains, when multiple Dante domains will share the same clock domain).

### About Leader Clocks

The Dante network leader clock (often also referred to as the 'Primary Leader'), is displayed at all times in the center of the toolbar of the Network View. This is the device that is providing the time sync source for all devices on the network.

If multiple clock domains are in use, the leader clock for each domain is shown, in a comma-separated list.

The leader clock is chosen automatically through an election process, though there are user configurable parameters that allow prioritization of some devices in the leader clock election. Configuring a device to have an external word clock source will force that device to become leader clock, unless another device has 'Preferred Leader' set.

Checking the 'Preferred Leader' flag will always result in that device (or the device with the lowest MAC address, if more than one device has been checked) becoming leader clock for that domain.
Note: If the leader clock device is not directly visible to Dante Controller (for example, if the leader clock device is for some reason only connected to the secondary network, and Dante Controller is only connected to the primary network), the 'Leader Clock' display in the toolbar may show a MAC address string, instead of the device name.

Clock Status Monitoring

Dante devices are monitored by Dante Controller to establish the status of their clock synchronization with the Dante network leader clock.

There are two levels of monitoring: 'passive' and 'active'.

In passive mode, Dante Controller will report if a clock loses sync (or regains sync) with the leader clock. In active mode, Dante Controller will also report if a clock is showing signs of instability. If a device clock is significantly unstable, it can lose sync with the leader clock, which will result in the device being automatically muted.

Why would a device clock be unstable?

There are a range of network conditions that can interfere with a device's clock stability. These include:

- A switch on the network is configured to use Energy Efficient Ethernet ('Green Ethernet') functionality
- A 100 Mb switch or link is present where a Gigabit connection is required
- One or more switches are incorrectly configured
- A 'problematic' external word clock is being used as the leader clock

Refer to the Dante FAQs for more information.

Passive monitoring

Passive monitoring is on all the time. If a Dante device loses sync with the leader clock, or regains sync with the leader clock, it reports the event to Dante Controller. Dante Controller records these events in a log file, and also will display an alert: the Clock Status Monitor icon (at the bottom right corner of the main window) will light up red.

Clicking the icon opens the Clock Status Monitor, which includes the clock status event log, and a clock status histogram.

Active Monitoring

When active monitoring is switched on, Dante Controller begins actively monitoring the behaviour of supported devices to identify signs of clock instability. If a clock exhibits significant instability, the Clock Status Monitor icon will light up amber, and a warning event will be recorded in the clock status event log.
Click the icon to open the Clock Status Monitor. Active monitoring is off by default. To activate it, click the Clock Status Monitoring button on the main toolbar.

When Active Clock Status Monitoring is active, the button is shown in green.

To switch it off, click the button again.

⚠️ **Note:** Active monitoring does not affect passive monitoring.

**Which devices are supported?**
Dante PCIe cards, Dante-MY16-AUD cards, Ultimo (low channel count) devices and devices that include a 'Brooklyn II', 'Broadway' or 'HC' Dante module support active monitoring.

Check the **Dante Model** value in the Dante Information section of the **Device View > Status** tab to identify your device type.

# Clock Status Monitor

The Clock Status Monitor includes two tabs, Log and History.

**Log**

The Clock Status log shows time-stamped clock status events for each device that has been identified as unstable, or has lost or regained sync with the leader clock.
The event types are:

- **Clock Sync Warning**: Indicates that a clock has been identified as unstable, and is at risk of losing sync with the leader clock.
- **Clock Sync Unlocked**: Indicates that a device has lost sync with the leader clock. This will result in the device being automatically muted until it regains sync.
- **Clock Sync Locked**: Indicates that a device has regained sync with the leader clock.

To delete all Clock Status log entries, click **Clear**. This will reset the Clock Status Monitor icon to green.

**Note**: This will also clear all other event log entries (the Clock Status log is a filtered view of the main event log).

Dante Controller will then resume monitoring (unless the Clock Status Monitoring button is switched off). To save the event log as an xml file, click **Save**.

### History

The History tab can be used to establish the stability of device clocks. It shows a histogram of clock frequency offset for the selected device, and the current frequency offset value, updated in real time.

The following information is also displayed:
- Mute status
- Sync status
- External word clock
- Preferred leader status

**About Clock Offset**

Hardware clocks are based on a vibrating (piezoelectric) quartz crystal. All crystals are slightly different, and vibrate at slightly different frequencies. When a device ('follower') clock wants to sync to a leader network clock, its frequency must be 'pulled' up or down to match the frequency of the leader clock. The amount that the clock's frequency is pulled is referred to as 'offset'.

Hardware clocks can only support a certain amount of offset, referred to as 'pull range'. If the pull range is exceeded, the follower clock will lose sync with the leader clock, and the device will be automatically muted.

Software clocks typically use an algorithm to derive a clock from an internal counter. Software clocks can support any amount of offset.

Rapidly-changing offset can also cause a follower clock to lose sync with the leader clock.

Various factors can destabilise follower clocks by affecting their offset, such as:

- Overloaded network links
- Poorly-implemented EEE (Energy Efficient Ethernet)
- A leader clock that is derived from an inaccurate external word clock (one that does not run at its nominal frequency)

**About the Histogram**

The horizontal axis of the histogram shows the distribution of clock frequency offset measurements against the nominal frequency of the clock, in parts per million (ppm). The zero point of the horizontal axis corresponds to the clock's nominal frequency (i.e. the frequency that the clock is intended to run at - for example, 98kHz).

The vertical axis shows the number of measurements recorded at each data point, on a logarithmic scale.
The histogram is continually updated, with measurements taken roughly once per second.

- To select devices, click the drop-down menu at the top.
- To clear the histogram, click **Clear**.
- To save a png format screenshot of the current data, click **Save**.

**Interpreting the Histogram**

The histogram can be seen as an indication of how much work a follower clock is doing to stay in sync with the leader clock.

Generally, a stable and accurate clock will show consistently stable offset (with variation in the order of a few ppm). It means that it is not having to change its offset very much to stay in sync.

*Show me*
A histogram that shows a distributed range of offsets indicates an unstable clock - it is having to change its offset significantly, and often, to stay in sync with the leader clock. This can be due to overloaded network links, or poorly-implemented EEE. A device in this state is highly likely to lose sync with the leader clock.

*Show me*

A histogram that shows measurements in amber and/or red indicates a clock that might be currently stable, but has little room for manoeuvre; its offset could easily move outside its pull range, at which point it will lose sync completely. This can result when the leader clock is derived from an inaccurate external word clock.

*Note:* Dante Controller can be left running for a few days (or even weeks) to collect clock status data, providing a long-term picture of the stability of your network clocking configuration.

*Show me*
The Network Status tab provides a range of network-related information across all devices in the network. This view includes subscription status, bandwidth and latency information, and can be used to quickly identify any potential network traffic issues. For DDM networks, devices are grouped into their respective IP subnets.

The tabular view presents the following information, in columns from the left:

**Device Name**
The device name currently associated with the device.

**Subscription Status**
The icon in the Subscription Status column displays a summary of subscription states for the device. If any of the device’s channels are not successfully subscribed, the relevant icon will be displayed here. See [Subscribing to Audio Channels](#) for information about the various icons that can be displayed in the Subscription Status column.

**Primary Status**
The Primary Status column indicates the link speed of the primary Dante network interface for the device.

**Secondary Status**
The Secondary Status column indicates the link speed and status of the secondary Dante network interface for the device (if applicable). 'N/A' indicates that the device does not have a secondary interface. 'Link Down' indicates that the device has a secondary interface, but it is not currently connected.

**Bandwidth Columns**
Use the bandwidth columns to see an approximation of transmit and receive traffic over individual device interfaces.

- **Primary Tx B/W**
  
  The Primary Tx B/W column displays an approximation of the current transmit bandwidth on the primary Dante network interface for the device.

- **Secondary Tx B/W**
  
  The Secondary Tx B/W column displays an approximation of the current transmit bandwidth on the secondary Dante network interface for the device.
The Secondary Tx B/W column displays an approximation of the current transmit bandwidth on the secondary Dante network interface for the device.

- Primary Rx B/W
  The Primary Rx B/W column displays an approximation of the current receive bandwidth on the primary Dante network interface for the device.

- Secondary Rx B/W
  The Secondary Rx B/W column displays an approximation of the current receive bandwidth on the secondary Dante network interface for the device.

**Latency Setting**
Shows the current latency setting for the device.

ℹ Note: For video (Dante AV) devices, the latency setting applies only to the audio channels.

**Latency Errors**
The Latency Errors column displays icons representing the recent latency performance of the device.

- A green light indicates that the device is subscribed, and there are no latency problems - i.e. all audio packets are arriving well within the device's latency setting.

- An amber light indicates that audio packets for one or more channels are arriving at or near the limit of the device's latency setting. You may need to increase the device's latency, or reconfigure the network to prevent audio glitches due to packet loss from late-arriving audio packets.

- A red light indicates that one or more audio packets have arrived outside the device's latency setting. This will result in audio glitches. The device's latency setting should be increased, or the network reconfigured (for example, by reducing the number of network nodes in between the transmitter and the receiver).

- A grey light indicates that the device is not currently subscribed.

**Packet Errors**
A red light in the Packet Errors column indicates that one or more media packets have been corrupted in between the switch and the receiver. This is usually due to a faulty Ethernet cable.

Use the Clear Counters button in the Device View > Status tab to clear the packet errors history for a device.
The Events tab provides information on significant changes and failures in the network. Dante Controller continually monitors Dante devices and the network as a whole. It is able to watch for problematic configurations, unexpected problems and communication failures between itself and Dante network devices. Events are displayed and stored in an event log.

Events fall into one of three categories: Information, Warning and Error.

Filtering the Event List

Use the drop-down menu at the bottom left of the view to filter the events list.

- When set to **Information**, all events are shown.
- When set to **Warning**, only warning and error events are shown.
- When set to **Error**, only error events are shown.

Clearing the Event List

To clear the event list, click the **Clear** button. When new events are detected that match the current filter setting, they are displayed in the event list.

If you have switched to another Network View tab, new events in the event list will also be indicated by a red Event Log LED icon in the **Status Bar**. Clicking the LED icon will take you straight to the Events tab and will clear the Event Log LED.

**Note:** The Event Log LED icon will always remain green while the Events tab is open.

Saving the Event Log

To save the event list, click the **Save** button. The list is saved as a text file with file extension .log. All events in the list are saved (the filter does not apply to saved events logs).
Automatic event logging
Events are also continuously written to a log file. Each time Dante Controller is started, it creates a new log file (with a time-stamped filename, to avoid overwriting previous logs).
You can find the path to these log files under Help > About. To delete log files more than seven days old, click the Delete old Log files button.

Event Classification
The following events are classified as Errors:
- Invalid link local address
- Subnet mismatch on dante interface
- Subnet match with non dante interface
- Multiple addresses with matching subnets
- Subnet conflict of dante interface on primary
- Subnet conflict of dante interface on secondary
- Unknown address error
- Fail Safe Mode
- Unknown device issue
- Elevation to Clock Leader
- Fanout Configuration detected
- Mismatched clock pullup subdomain
- Wrong subdomain for pullup
- Unknown subdomain
- Audio mute / Audio unmute
- Clock sync lock / unlocked

The following events are classified as Warnings:
- Resolution Failed
- Elevation to Primary Leader
- Multiple external clock sources
- Cannot Elevate to Clock Leader
- Clock Sync Warning

The following events are classified as Information:
- Request Timeout Error
- Response Timeout Error
- Demotion from Clock Leader
- Demotion from Primary Leader
- Reboot required
Automatic Notification of Device Errors

Dante Controller is able to identify several types of problems that a Dante device may experience. A device that is found to have problems will have its device name displayed in red. Additional information about the problem can be found by double-clicking on the device.

A device displayed in red will either have entered failsafe mode, or will have an identified issue with its IP configuration. These states are described in more detail below.

A device displayed in orange ('Ultimo' low channel count devices only) will have entered upgrade mode (see below).

Incorrect IP address configuration

Dante networks use IP Addressing to communicate. Incorrect address configuration can make it hard or impossible for a Dante device to communicate. Dante Controller attempts to identify and report several types of incorrect IP address configuration, including:

- Having multiple DHCP servers on the same network
- Incorrectly configured static IP addresses
- Connecting the secondary interface of a Dante device to the primary network
- Different interfaces on the same device using the same IP address subnet
- Configuring a DHCP server on the primary network to use the IP address range reserved for secondary link local devices (172.31.*.*)

If you need further information, please refer to the Troubleshooting section.

Failsafe mode

A device will enter failsafe mode when the firmware image stored on the board has become corrupted. Although rare, this can occur when:

- The firmware update process is interrupted by power loss or network failure
- The firmware image itself that was used in an upgrade is corrupt

If your device enters failsafe mode, please use the Failsafe Recovery function in the Firmware Update Manager application (if available) or contact your device manufacturer.

Upgrade mode

When some 'Ultimo' devices (technically, those that include an internal Ethernet switch) are upgrading, or have finished upgrading but have not yet been rebooted, they are in 'upgrade mode', and are displayed in orange text in Dante Controller. While in this mode, an 'Issues' tab is visible in the Device View for the device, indicating their current state.

When these devices have had new firmware applied, they must be ‘manually’ rebooted by the user, via Dante Controller (unlike other devices which reboot automatically as part of the upgrade process). This is because any daisy-chained Dante devices downstream of the upgraded device will not receive media or firmware update data via that device while it is rebooting. The manual reboot option allows you to control when the device reboots, and thus prevent:
- Interruption of media to any downstream daisy-chained devices until it is convenient, and
- Interruption of firmware update data to any downstream daisy-chained devices that are also in the process of updating - which in some devices can lead to the update failing, and the device entering failsafe

When the device has rebooted, media flow to any downstream daisy-chained devices will resume automatically.

**Other Event Notifications**

Dante Controller will also notify you of network status, general device events and clock status events, via the LED icons in the [Status Bar](#).

**Device View**

The Device View is used to view and modify detailed information and settings for a specific device. Device view can be activated by double-clicking a device name in any of the Network View tabs (except Events), or by selecting **Device View** from the **Device** menu (Ctrl + D, or Command + D) in the Network View window. The Device View opens in a new window. Multiple device views can be open simultaneously.

**Note:** macOS users: Please note that the key combinations shown below are for Windows users. When using Dante Controller on a Mac, use the 'Command' or 'Apple' key instead of the Ctrl key when following the instructions below, and substitute standard Mac key combinations where applicable - see the Dante Controller menus for details.
The name of the device being viewed is displayed in the middle of the toolbar. In the screenshot above, FOH-Console is the device being displayed in the drop-down list box.

The device viewed can be changed by selecting another device from the drop-down list.

Multiple Device View windows may be opened from the Network View, so that several devices can be examined simultaneously.

The Device View displays some or all of the following tabs, allowing you to see different information relating to a specific Dante device:

- **Receive**: Display and configure device’s receive (Rx) channels
- **Transmit**: Display and configure device’s transmit (Tx) channels including multicast
- **Status**: Device software, clock and network status information
- **Latency**: View latency histograms (supported devices only)
- **Device Config**: Rename device, change sample rate and set other attributes (as relevant to device type)
- **Network Config**: View and edit network configuration
- **Issues**: Displays information for devices in failsafe mode, or upgrade mode (upgrade mode is used by 'Ultimo' low channel count devices only). Not usually visible.
- **Baseboard**: Only available when the Dante device is mounted on a Dante PDK audio baseboard (NOTE: the device must be in SPI master mode)

There are also dedicated configuration tabs displayed only for specific devices.
Device View Menu bar

The menu bar in the Device View contains the following menus:

File
- Close Window

Devices
- Refresh: Refreshes the displayed network / device data
- Create Multicast Flow
- Identify: Identify the current device by, for example, causing its LEDs to flash.
- Lock / Unlock
- Clear Domain Credentials

View
- Show/Hide Channel Groups
- View Flow Information

Help
- About: Shows Dante Controller version and current log file
- License: Displays the license text
- Online Help: Opens this HTML user guide on the Audinate web server (requires an Internet connection)
- Offline Help: Opens a locally-stored PDF of this user guide (may not be the latest version of the user guide)

Device View Toolbar

The Device View toolbar contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Re-load routing and configuration information for the current device.</td>
</tr>
<tr>
<td><img src="image" alt="Web Config" /></td>
<td>Some Dante devices can be configured via a web interface. This button opens a web browser window which can be used to perform functions such as firmware upgrades. This feature is not supported on all Dante devices.</td>
</tr>
<tr>
<td><img src="image" alt="Identify" /></td>
<td>Identify the current device by, for example, causing its LEDs to flash. Note that this feature is not supported on all Dante devices.</td>
</tr>
<tr>
<td><img src="image" alt="Multicast" /></td>
<td>Configure multicast transmit flows on the current device.</td>
</tr>
<tr>
<td><img src="image" alt="Channel Groups" /></td>
<td>Activate / deactivate Channel Groups.</td>
</tr>
</tbody>
</table>
The toolbar also provides a drop down list of all available devices on the network, which allows you to switch the Device View to a different device.

Device View Tabs

The Device View is split into tabs, some of which are only applicable to certain devices. Each tab is described in detail below.

Receive Tab

The Receive tab displays a list of all subscribed and dormant receive channels on the current device, plus subscription information for the subscribed channels. It also allows the creation of subscriptions from the Available Channels list.

The tab is split into two panes: Receive Channels, and Available Channels.

Receive Channels

The Receive Channels pane contains three columns:
- Channel: Lists the receive channel names for the current device. These can be edited here to rename the channel.

- Connected To: Lists the Tx channel that the receive channel is currently subscribed to, plus the status of both primary and secondary subscriptions, using the following icons:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Green Checkmark" /></td>
<td>Subscription is OK and media should be flowing</td>
</tr>
<tr>
<td><img src="image" alt="Warning Triangle" /></td>
<td>Subscription is unresolved - usually because the transmitting device has been removed from the network, or is switched off</td>
</tr>
<tr>
<td><img src="image" alt="Red Circle" /></td>
<td>No subscription, or a subscription error</td>
</tr>
<tr>
<td><img src="image" alt="Unicast Connection" /></td>
<td>Subscription is via unicast connection</td>
</tr>
<tr>
<td><img src="image" alt="Multicast Connection" /></td>
<td>Subscription is via multicast connection</td>
</tr>
</tbody>
</table>

Subscriptions can show several symbols in the Status column. Common status icon combinations and their meanings are as follows:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Unicast Connection" /> <img src="image" alt="Unicast Connection" /></td>
<td>Unic和平 device successfully subscribed to a transmitter</td>
</tr>
<tr>
<td><img src="image" alt="Unicast Connection" /> <img src="image" alt="Unicast Connection" /> <img src="image" alt="Unicast Connection" /></td>
<td>Redundant device successfully subscribed on both primary and secondary via unicast</td>
</tr>
<tr>
<td><img src="image" alt="Multicast Connection" /> <img src="image" alt="Multicast Connection" /></td>
<td>Redundant device successfully subscribed on both primary and secondary via multicast</td>
</tr>
<tr>
<td><img src="image" alt="Unicast Connection" /> <img src="image" alt="Unicast Connection" /> <img src="image" alt="Multicast Connection" /></td>
<td>Redundant device successfully subscribed on primary only via unicast. This is typically seen when the secondary interface is not connected</td>
</tr>
</tbody>
</table>

- Signal: Supported devices will also show the following channel metering icons, indicating the presence of audio on subscribed channels:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mute" /></td>
<td>Channel is either muted, or receiving audio at less than -61dbFS</td>
</tr>
<tr>
<td><img src="image" alt="Audio Level" /></td>
<td>Channel is receiving audio between -61dbFS and 0dbFS</td>
</tr>
<tr>
<td><img src="image" alt="Clipping" /></td>
<td>Channel is clipping</td>
</tr>
</tbody>
</table>

For video, ancillary and privately-encoded audio channels, supported devices may also show variations of the following status icons in the Signal column:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Network Connection" /></td>
<td>The signal path (across the network) is good, and there are no external connectivity problems detected</td>
</tr>
</tbody>
</table>
The signal path is good, but Dante Controller cannot ascertain if there are any external connectivity problems

The signal path is good, but the Rx device does not support the signal (for example, because the signal is HDCP and the Rx device is not HDCP-enabled)

Indicates a signal problem such as an incompatible video codec, or the Dante subscription is unresolved. Refer to the subscription status icon for further information.

The signal path is good, and the signal is encrypted

Available Channels
The Available Channels pane lists the devices and advertised channels available on the network. Devices that are greyed out indicate that this receiver cannot subscribe to those channels or devices. This is typically because of a mismatch in parameters (e.g. sample rate incompatibility etc.), or because a device cannot route media to itself.

For devices with many channels, you can click the Channel Groups button to group available channels into sets of 16.

AES67 Flows
‘Devices’ with multicast IP address names (e.g. 239.69.82.194) are actually AES67 flows, which can only be received (or transmitted) by AES67-enabled devices.

Note: If they are displayed in blue, the currently-selected device is AES67-enabled, and can receive AES67 flows. If they are displayed in grey, the currently-selected device is not AES67-enabled.

Creating Subscriptions
Subscriptions are created by selecting a channel from the Available Channels list in the right-hand pane of the Receive Tab, then dragging and dropping it onto the appropriate receive channel in the left-hand pane of the Receive Tab.

Multiple channels can be selected and then dragged and dropped onto the Receive Channels pane, to make several subscriptions simultaneously. You can also drag and drop channel groups to make bulk subscriptions.

Changing Receive Channel Names
To change a receive channel name, click the name and type in the new value.

Transmit Tab
The Transmit tab is used to inspect and modify the transmit configuration of a device.
The Transmit Tab is arranged in two areas:

- **Transmit Channels**: The area on the left pane of the tab shows the Tx channels for the device. It allows you to edit channel names for transmit channels. Input to the table is filtered to prevent illegal characters from being used in channel names.

  Supported devices will also show the following channel metering icons in the **Signal** column, indicating the presence of audio on subscribed channels:

  **Channel**
  
  - ![Volume Mute](image1) Channel is either muted, or receiving audio at less than -61dbFS
  - ![Volume Clip](image2) Channel is receiving audio between -61dbFS and 0dbFS
  - ![Volume Clip](image3) Channel is clipping

For video, ancillary and privately-encoded audio channels, supported devices may also show the following status icons in the **Signal** column:

  ![Connectivity](image4) Indicates there are no external connectivity problems with the Tx device
- Indicates there is an external connectivity problem with the Tx device
- Dante Controller cannot ascertain if there are any external connectivity problems with the Tx device

- **Multicast Transmit Flows**: The area on the right pane of the tab shows the multicast transmit flows that have been configured on the device.

  Multicast flows are listed in ID order, including the channels contained within the flow. [AES67 and SMPTE multicast flows](#) are identified as ‘RTP’ multicast flows, and also include the destination IP address for the flow.

  **Note**: Unicast flow details are displayed in the *Flow Information* dialog.

### Changing Tx channel Names

To change a Tx channel name double click on the name and type in a new one. Tx channel names must be unique for the device.

### Status Tab

The Status tab is used to obtain current information about a Dante device.
The tab is divided into sections. The information presented on this tab can be very useful when investigating networking or clocking issues in the system. The Refresh button can be used to update this information if required.

**Note:** Not all Dante devices support the display of all of this information.

### Device Information
This provides the following general information about the device:

- **Manufacturer:** The name of the device manufacturer.
- **Product Type:** The type of device.
- **Product Version:** The product version.
- **Software Version:** The version of the manufacturer software running on the device.
- **Firmware Version:** The version of the manufacturer firmware running on the device.

### Dante Information
This provides Dante-specific information about the device:
- Model: The Dante device type.
- Dante Firmware Version: The version of the Dante firmware running on the device.
- Hardware Version: The version of the hardware firmware running on the device.
- ROM/Boot version: The version of the ROM or bootloader.

Clock Synchronization

This provides the following information about device clocking:

- **Mute Status:** 'Muted' indicates that the device is has been automatically muted (due to a clock synchronisation problem, or because the external word clock is invalid). 'Unmuted' indicates that the device is not muted, and audio is flowing normally.
- **Sync Status:** 'Locked' indicates that the device is locked to the network PTP clock. 'Not Locked' indicates that the interface has not achieved lock with the network PTP clock.
- **External Word Clock:** 'No' indicates that the device has been configured to use the internal clock source. 'Yes' indicates that the device has been configured to accept an external word clock source. NOTE: If the Dante device is configured to accept an external word clock source, it is important to make sure that the host equipment has been configured to provide its word clock to the Dante device. Check your product manual for more information.
- **Preferred:** 'No' indicates that the card has not been set to preferred leader mode. 'Yes' indicates that the card is set to preferred leader mode.
- **Frequency Offset:** Indicates the offset from the network clock leader measured in parts-per-million.

Primary Interface

Provides the following information about the primary network interface:

- **IP address:** The IP address currently assigned to the interface
- **MAC address:** The Media Access Control address of the interface, associated with the Ethernet layer
- **Tx Utilization:** Shows the current total transmit bandwidth in use
- **Errors:** (on the same line as Tx utilization) shows the number of transmit Cyclic Redundancy Check (CRC) or packet errors detected since the device was last started
- **Rx Utilization:** Shows the current total receive bandwidth is use
- **Errors:** (on the same line as Rx utilization) shows the number of receive Cyclic Redundancy Check (CRC) or packet errors detected since the device was last started

**Note:** The Rx Utilization includes not only network traffic destined for the Dante device, but any other multicast or broadcast traffic received at this network interface.

**Note:** As a rule of thumb neither the Rx nor the Tx utilization should exceed about 85% of the link speed in order to guarantee good clock synchronization performance (links are full duplex).

The graphic also indicates the speed and connected state of the interface as follows:
Indicates that the link is operating at 1Gbps

Indicates that the link is operating at 100Mbps

Indicates that the link is not connected, or that there is an error. The IP address will read N/A, and Tx and Rx utilization will be 0 kbps.

**Clear Counters**: Click this button to reset the packet errors history for the device.

**Secondary Interface**
This provides the same information for the secondary interface that is provided for the primary interface, as described above.

**Note**: The secondary network interface will only be displayed if the device supports redundancy.

**Latency Tab**
For supported devices, the Latency tab displays histograms of audio packet latency for each transmitter that the device is subscribed to.

**Note**: For video (Dante AV) devices, latency settings made in Dante Controller apply only to the audio channels.

*Which devices support latency monitoring?*
Newer Brooklyn II, Broadway, HC, PCIe and Ultimo devices support latency monitoring in Dante Controller. You can check your device type in the Device Info tab.

**About Latency and Packet Loss**
Latency is used to account for the delay between an audio packet leaving the transmitter, traversing the network (potentially through multiple switches) and reaching the receiver.

If a receiver's latency setting is too low, audio packets will not have time to get from the transmitter to the receiver before they are supposed to be played out. When this happens, the receiver will drop packets (i.e. it will throw packets away, because they are 'late to the party').

Packet loss results in audio glitches, so it is very important to ensure that all receivers have their latency set high enough to prevent packet loss.
Setting device latency too high, however, can interfere with low-latency applications (for example, real-time monitoring when recording vocals), so it is sometimes important to find a balance between low latency and guaranteed audio integrity.

The Latency tab can be used to identify:

- Devices that are dropping packets because their latency is set too low
- Devices that are at risk of dropping packets because their latency is set too low
- Devices that could potentially have their latency reduced (if required; generally, the default Dante latency of 1ms is more than adequate for low-latency applications)

**About the Histogram**

The transmitter's name is displayed at the top of the histogram, along with the latency value against which the histogram is reporting.

The horizontal axis shows the distribution of audio packet latency measurements from the transmitter. The vertical axis shows the number of measurements recorded at each data point, on a logarithmic scale.

Measurements are taken at roughly 1 second intervals, from when Dante Controller is started.

To clear the histogram, click **Clear**. Latency measuring will then restart.

To save the histogram as a png image, click **Save**.

**Note:** If any subscriptions are via multicast flows, there may be two histograms displayed for one transmitter: one histogram for the unicast flows, and one for multicast. This is because multicast flows always use a latency of 1ms. If the receiver is set to a latency other than 1ms, two histograms will be displayed.

The following information is also displayed:
The latency **Setting** for the histogram. In most cases, this will be the same as the latency setting on the receiver. However, for some subscriptions, Dante will automatically apply a different latency. For example:

- Multicast flows are automatically set to a minimum of 1ms
- If a transmitter does not support the latency set on the receiver (i.e. it can't guarantee delivery within the required latency), Dante will increase the latency to the lowest setting supported by the transmitter. Ultimo devices, for example, support a minimum latency of 2ms, so subscriptions to Ultimo devices will use a minimum of 2ms latency.

- The **Peak** latency since measuring started
- The **Average** latency since measuring started
- The number of measurements taken that included one or more **Late** packets (note that each measurement typically includes many packets)

**Interpreting the Histogram**

If all bars are green and falling well within the limit of the histogram (i.e. towards the left or middle of the histogram), it indicates that the latency setting for the receiver is set high enough to prevent packet loss.

*Show me*

If any bars are amber, it means that some packets are arriving near the limit of the latency setting. Network traffic fluctuations could potentially lead to extra delay which could cause packets to arrive late. A histogram of this type indicates that the receiver latency should be increased if possible.

*Show me*
If any bars are red, it indicates late packets, and audio loss. The receiver latency should be increased, or the network reconfigured.

**Note:** Dante Controller can be left running for a few days to collect latency data, providing a long-term picture of the latency performance of your network configuration. This is especially useful after any network infrastructure upgrades, or after the addition of more end point load in a given network, to determine if QoS tuning or increased capacity may be required at the network switch level.

*Show me*
**Device Config Tab**

This tab on the device view window allows you to configure device specific parameters. The specific options available will depend on the capabilities of the device. In the case where a device does not support configuration via Dante Controller, the tab will be disabled.
Configurable Parameters

Rename Device

Allows you to enter a new Dante 'friendly name' for the device. The text field displays the current name. To change the device name, enter a new name in the text field and press Enter.

See Device and Channel Names for information about name conflicts and device name rules.

Sample Rate

- Shows the current sample rate of the device, and allows you to change the operating sample rate of the Dante device. This may require the device to be rebooted to take effect. All sample rates supported by the device are shown in the drop down menu.
- Shows the current pull-up/down setting for the device, and allows you to change the pull-up/down setting. The pull-up/down setting can be used to adjust the sample rate of the device to synchronise audio with video that has undergone frame rate conversion. For example, to synchronise Dante audio with video that has been converted from 24 fps to 25 fps, set the sample rate pull-up/down for any relevant Dante audio devices to +4.1667%.
- Applies to audio channels only.
Note: Changing the sample rate pull-up/down for a device places that device in a dedicated clock domain. Dante devices can only transmit audio to, or receive audio from other devices on the same clock domain. See Clock Status View for more information.

Preferred Encoding

Shows the current preferred encoding setting and allows you to change the preferred encoding setting for the device.

Note: This setting does not guarantee that the device will use always the selected encoding: Both devices must support the selected encoding for it to be used.

Unicast Delay Requests

Delay requests are messages sent by clock followers to the clock leader to establish the time it takes for data to traverse the network between the devices. By default, delay requests are multicast messages, and in networks with lots of devices, they can add up. Enabling 'Unicast Delay Requests' forces clock follower devices to send delay requests to the clock leader using unicast instead, which reduces multicast traffic.

Note: Unicast Delay Requests does not have to be enabled on the clock leader, only on the clock followers.

Important: Some older Dante devices do not support Unicast Delay Requests. Before enabling the feature for your clock followers, check that your current clock leader supports the feature, by attempting to enable it for the device. If the clock leader device does not support unicast delay requests, do not enable it on your clock followers (it may prevent your devices from synchronizing). You can however choose an alternative clock leader that does support it, and then enable it for the clock followers that also support it.

Device Latency

Shows the current device latency setting, and allows you to change the operating receive latency for the selected device. Select a value and click OK to apply the latency to all flows that the device is receiving.

Note: The 150 µsec setting is unavailable for devices that include an internal network switch.

Note: Device latency cannot be configured for Dante Via devices.

Note: Devices enrolled in a Dante domain may support extra latency values.
Warning: Changing the latency value will cause disruption in the audio while the flows are re-established at the new latency setting.

Reset Device

Allows you to remotely reboot the Dante interface, and also to reapply factory settings (Factory Reset). Rebooting the Dante device may also require a reset of the host audio equipment containing the device.

Factory Reset wipes the following device configuration settings:

- User-defined device name
- User-defined channel names
- Clock configuration (clock leader / external clock leader setting)
- Static IP addresses
- Redundancy configuration
- Sample rate setting (including pull-up/down)
- Latency setting
- Any existing audio routes

Supported devices allow you to 'Clear Config' instead of Factory Reset. Clear Config wipes the same configuration settings listed above, but allows you to optionally keep the IP settings (i.e. retain the Dante Redundancy settings, and any static IP addresses currently configured in the Network Config tab).

A reboot is required after clearing the configuration for the changes to take effect. Some devices will allow you to automatically reboot after clearing the configuration. If this option is not available, a manual reboot is required.

Plugins

Some devices may present additional 'plugin' tabs, defined by the device manufacturer, for configuration and display of additional device settings, such as video format and/or ancillary channel settings.

The contents of these tabs will vary based on the controls and information that the device manufacturer has chosen to expose.

Refer to the user guide for your particular device for more information.

An example Video Config plugin tab is shown below.
**Network Config Tab**

Use the Network Config Tab to toggle supported devices between Redundant and Switched modes, and to specify static IP addresses for a device's Ethernet ports.
Dante Redundancy / Switch Configuration

Depending on the manufacturer's configuration of a device, it may be possible to toggle the device between Redundant and Switched modes, or to select a Switch Configuration.

**Redundant**

When a device is set to Redundant, the device will duplicate Dante media traffic to both Ethernet ports, allowing the implementation of a redundant network via the secondary port. Not all devices support redundancy.

**Switched**

When a device is set to Switched, the secondary Ethernet port will behave as a standard switch port, allowing daisy-chaining through the device.

**Switch Configuration**

Certain devices support specialist switching and/or redundancy configurations for the Ethernet ports. For these devices, the top pane of the Network Config tab will be titled 'Switch Configuration'. Please refer to the manufacturer's technical documentation for information on the supported switching configurations for the device.

**Addresses**

Dante devices obtain IP addresses automatically by default, and in the vast majority of circumstances there is no need to change the Addresses settings. However, static IP addresses can be assigned if necessary.

To assign a static IP address:
1. Select 'manually configure an IP Address' for the appropriate Ethernet port.
2. Enter the IP Address and Netmask.
3. Click **Apply**.

The DNS Server and Gateway settings are optional - the device will use network defaults if they are not specified.

Click **Revert** to revert back to the previous settings.

**Note:** Assigning static IP addresses requires a device reboot.

**Interop Status Tab**

For enrolled devices in a DDM network, the Interop Status tab shows the current interoperability mode for the device:

- **SMPTE:** The device is enrolled in a SMPTE domain, and is configured in DDM to enable RTP flows
- **AES67:** The device is enrolled in an AES67 domain, and is configured in DDM to enable RTP flows
- **None:** The device is enrolled in a standard Dante (non-RTP) domain

The RTP multicast destination address prefix is also shown for devices in SMPTE or AES67 mode.
AES67 Config

For supported devices (Brooklyn II v3.9.x devices and up), the Device View also includes an AES67 Config tab. The AES67 Config tab allows the selection of AES67 mode for the device.
AES67 is a standard for audio over IP interoperability. Devices in AES67 mode are able to transmit and receive AES67 multicast flows to/from non-Dante AES67-enabled devices. Between Dante devices, Dante's native audio transport protocol is used instead (even when AES67 is enabled for both devices).

**Note:** When the device is enrolled in a domain, AES67 configuration is controlled via DDM instead, and the AES67 tab is not available.

**AES67 Mode**
Select **Enabled** to enable AES67 mode for the device.
Use the [Create Multicast Flow](#) panel to create AES67 flows.

**RTP Multicast Address Prefix**
You can use the RTP Multicast Address Prefix field to specify a multicast subnet, for cases where you need to transmit to or receive from a particular address range.
The multicast address prefix set at device level does not affect which AES67 flows from non-Dante devices are displayed in Dante Controller. However, when subscribing a Dante device to a non-Dante Tx flow, the multicast address prefix set for the receiver must match that of the Tx flow. If they do not match, the subscription will appear to succeed, but audio will not actually flow.
**Note:** Dante devices are able to transmit AES67 flows on any IP address. However, some devices (specifically, Brooklyn II, HC and Broadway-based devices) will only subscribe to AES67 flows in the 239.x/16 address range. If you need to subscribe any of these Dante device types to an AES67 flow from a third-party device, ensure that the transmit flow is in the 239.x/16 address range.

**Note:** Presets do not support AES67 flows.

**Controls Tab**

For supported devices, the Device View also includes a Controls tab. Use the Controls Tab to adjust audio controls for the selected device.

The displayed control set varies between devices.

![Controls Tab](image)

**HA Remote Tab**

For supported devices (Dante-MY16-AUD cards v3.3.9 and up), the Device View also includes an HA Remote tab. The HA Remote tab allows the selection of the HA Remote bridging mode for the device.
HA Remote is a proprietary serial control protocol used by Yamaha products. For more information about HA Remote bridging modes, please download the latest version of the Dante-MY16-AUD user guide from the Yamaha website.

**Avid Config Tab**

For supported devices (DNT-192 expansion cards), the Device View also includes an Avid Config tab. The Avid Config tab allows the configuration of the DNT-192 card, and displays relevant firmware and hardware version information.
The tab includes 3 sections:

- Avid Dante Card Information: Displays information about card hardware and software versions
- Avid Rack Status Information: Displays information about the rack status for the card
- Avid Dante Card Control: Allows the configuration of various DNT-192 settings

**Avid Dante Card Information**

This section displays:

**Application version**

The version of the Dante application currently installed on the DNT-192 card.

**FPGA Version**

The version of the FPGA binary on the card.

**Board Version**

The hardware version of the card.

**Avid Rack Status Information**

This section displays:
Rack Sample Rate

The sample rate at which the rack is currently set to.

Rack Mute Status

The mute status of the rack.

Avid Dante card Control

This section allows high-level configuration of the DNT-192 card.

Card Configuration

In ‘Dante’ mode the card configuration is automatically set by the rack. In ‘Generic’ mode the configuration is manually selectable.

The Card Configuration option supports 3 values:

- Input card: The card functions as a 16-channel input device
- Output card: The card functions as a 16-channel output device
- Input/Output card: The card functions as an 8-in + 8-out device

SRC

Sample Rate Conversion.

When enabled, the card will convert incoming (Rx) audio to the Rack Sample Rate (if required), and outgoing (Tx) audio to the sample rate of the receiving device on the Dante network (if required).

Note that SRC adds latency of roughly 1.3ms to the Dante subscription in each direction.

Card Identity

- Dante: The card will identify itself as a Dante device to the host device rack, enabling Dante functionality on the host device. Required for Dante-enabled host equipment.
- Generic: The card will identify itself as a generic digital audio interface (required for non-Dante host equipment).

Flow Information

The Flow Information dialog displays any audio, video or ancillary flows to and from the device.

To open the Flow Information dialog, open the Device View for the device and select View > View Flow Information.

In the example below, the device supports 32 audio transmit flows and 32 audio receive flows.
Multicast Transmit Flow Configuration

Click the 'Create a new multicast flow' button in Device View to open the **Create Multicast Flow** dialog.
The dialog displays a list of the Tx channels for the device.

To add channels to a multicast flow, select the checkboxes for the channel name. Once you have selected all the channels required, create the multicast flow by clicking the **Create** button at the bottom of the dialog box. To abandon creating a new multicast flow, click **Cancel**.

Once a flow has been created, it will appear in the list of flows in the transmit pane, along with the channels contained within that flow. Channels cannot be added to or removed from existing flows. Each time the dialog is used to select additional channels, a new multicast flow will be created.

By default, Dante receivers will connect to a multicast flow if one exists that contains the required channel(s), rather than creating a new unicast flow.

If a channel that does not form part of an existing multicast flow is added to a new multicast flow, any existing unicast subscriptions to that channel will automatically switch over to use the new multicast flow.

A good rule of thumb is to use multicast when there are more than two receivers for a specific media channel. You should also assume that the flow will flood throughout the entire network, and therefore consume bandwidth on all network links.
Note: Some ancillary channel types for video (Dante AV) devices cannot be added to multicast flows.

**Maximum Channels per Flow (Audio Devices Only)**

The number of channels that can be added to a Dante multicast flow varies by device type. This is displayed at the top of this window, and is 64 channels for the device shown above.

If you select more channels than the maximum supported channels per flow, multiple flows will be created. For supporting devices, you can restrict flows to fewer channels if required, using the drop-down menu in the Flow Config section.

This control also affects the number of audio samples per packet:

<table>
<thead>
<tr>
<th>Maximum Channels Setting</th>
<th>Samples per Packet</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>32</td>
<td>8</td>
</tr>
<tr>
<td>64</td>
<td>4</td>
</tr>
</tbody>
</table>

Smaller packet sizes may enable lower device latency settings for relevant subscriptions - use the Latency tab in Device View to monitor latency performance.

Note: Dante devices on legacy (pre v4.2 firmware) will reject a 'create multicast flow' operation with more than 8 channels.

Note: Video flows support only 1 video channel.

**Managing Flow Size**

Multicast flows propagate through the network to every device that requests one or more of the channels in the flow. When considering network traffic management, in a typical network where no devices actually need all channels, it would be more advisable to create multiple flows than it would to create one flow containing all channels.

In the first example illustrated below, one multicast flow was created, containing four channels. None of the devices actually require all four channels, but both switches are processing four channels of traffic.

In the second example, two flows were created with two channels each. All devices are receiving the channels they need, but the switches are processing half the traffic.
Figure 1 - Single multicast flow with all channels

Figure 2 - Two multicast flows, with half the number of channels in each

Deleting Multicast Flows

Care should be taken when deleting a multicast flow, as the existing subscriptions will convert back to unicast. This has the potential to result in exceeding the link capacity or maximum number of flows at the transmit device, as multiple unicast flows will be established between the transmitter and its receivers. It may be advisable to remove some or all of the media routes prior to deleting the multicast flow.
Note: Certain Ethernet switches support IGMP (Internet Group Management Protocol), a protocol that provides the ability to 'prune' multicast traffic, so that it travels only to those end destinations that require that traffic. If this is the case, and IGMP is correctly configured on all the Ethernet switches, then multicast media will not flood throughout the network, but will instead be sent only over the links required to deliver it to subscribed devices.

AES67 Flow

The AES67 Flow option is only available for AES67-enabled devices. When AES67 Flow is checked, the selected channels will be added to an AES67 multicast flow. Only AES67-enabled devices can receive AES67 flows. Dante devices cannot subscribe to AES67 flows from other Dante devices.

RTP transmit flows (including AES67 flows) from non-Dante devices appear in blue at the far right of the Routing tab of the Network View, and at the bottom of the Available Channels list in the Device View > Receive tab. AES67 flows are identified by their transmit multicast IP addresses, rather than device names.

For AES67-enabled Dante devices, each device transmit channel can simultaneously support an AES67 multicast flow and a standard Dante multicast flow.

AES67 flows support 8 channels. If more than 8 channels are selected for an AES67 flow, multiple flows will be created.

Note: Dante devices are able to transmit AES67 flows on any IP address. However, some devices (specifically, Brooklyn II, HC and Broadway-based devices) will only subscribe to AES67 flows in the 239.x/16 address range. If you need to subscribe any of these Dante device types to an AES67 flow from a third-party device, ensure that the transmit flow is in the 239.x/16 address range.

SMPTE Flows

For DDM networks, supporting devices that are enrolled in a SMPTE-enabled domain can transmit and subscribe to SMPTE ST 2110-30 flows.
Creating SMPTE Flows

SMPTE flows created in Dante Controller are advertised on the network via SAP/SDP.

**Note:** Refer to the SMPTE Standard (SMPTE ST 2110-30:2017) for more information about SMPTE audio. Refer to the DDM User Guide for information about configuring RTP domains.

To create a SMPTE flow:

1. Open the Device View for the device and click the 'Create a new multicast flow' button.
2. Select the required SMPTE flow config.
   - SMPTE A: 48 kHz flow with up to 8 channels at packet times of 1ms
   - SMPTE B: 48 kHz flow with up to 8 channels at packet times of 125μs
   - SMPTE C: 48 kHz flow with 64 channels at packet times of 125μs
3. For the Destination Address:
   - Select 'Auto' to automatically assign the destination address and port number. The destination address will be assigned according to the RTP prefix configured for the domain in which the device is enrolled. For example, if the RTP prefix for the domain is 69, the device will create a flow with destination address of 239.69.x.x. The port number defaults to 5004.
   - Select 'Manual' to specify the address and port. The IP address must be in the range 239.0.0.0 to 239.254.254.254. The port can be set to any non-administrative port number.

4. Select the channels to be added to the flow, and click 'Create'. If the number of selected channels exceeds the maximum number supported by the config, multiple flows will be created.

The transmit flow will present in the controller software for your SMPTE receiver if it natively supports SAP/SDP parsing. If not, an alternative mechanism will be required to parse the SDP descriptor for the flow. The configuration of third-party SMPTE receivers is specific to the receiver.

**Note**: Renaming a Dante device will also rename any SMPTE flows from that device.

**Subscribing to SMPTE Flows**

SMPTE transmit flows from non-Dante devices present in Dante Controller as Dante transmitters with blue 'device' names. The device name is taken from the SDP descriptor for the flow as advertised by the device, or configured in Dante Domain Manager.

SMPTE channels can be subscribed to (by supporting devices) in the same way as channels from other transmitters.

If the transmitter does not advertise flows via SAP/SDP, you can use DDM to generate a 'proxy' RTP session with a descriptor that is supported by Dante Controller.
Note: The PTP v2 clock domain configured for the domain in DDM must match that of the flow. If they do not match, when you attempt to subscribe to the flow, Dante Controller will report 'Clock domain mismatch'.

Note: The RTP Prefix configured for the domain in DDM must match that of the flow. If they do not match, subscriptions will appear to succeed but audio will not flow.

For more information about SMPTE domain configuration and SDP descriptors, refer to the DDM user guide.
Using Dante Controller with Dante Domain Manager

About Dante Domain Manager

Dante Domain Manager (DDM) is a complete management solution for Dante systems.

With DDM, integrators can define specific AV device groupings, by room, building and site, allowing for the creation of independent Dante Domains, and enabling a single Dante Domain to encompass multiple network subnets.

DDM provides robust security for IT departments and AV managers, including user authentication and encrypted control, role administration and integration with Active Directory. System managers gain complete visibility and accountability with a suite of dashboards, audit trails, alerts and SNMP support.

DDM is a virtualized application that runs on desktop and server platforms, with an intuitive and highly responsive web interface for desktop, tablet and mobile browsers.

For more information about DDM, refer to the DDM user guide.

**Note:** DDM does not currently support video (Dante AV) devices.

Viewing Domains in Dante Controller

To view enrolled devices in Dante Controller, the user must connect to the DDM server using their configured DDM credentials, and then select the appropriate domain for viewing.

Connecting to a DDM Server

To connect to a DDM server:

1. In the Dante Controller toolbar, click the DDM / Dante Cloud Login button: ![DDM / Dante Cloud Login button](image)

   The DDM / Dante Cloud Login dialog is displayed.
2. In the DDM / Dante Cloud Login dialog, either:
   - Select ‘Auto-Detect Server’ to search for a DDM server automatically*, or:
   - Enter the relevant server name** (FQDN) or IP address, and the port number.
3. Enter your user name and password.
4. Click Log in.

* Auto Discovery requires DNS if Dante Controller and the DDM server are in different IP subnets.
** Requires DNS.

**First-time Connections**
The first time an installation of Dante Controller connects to a DDM server, a pop-up dialog is displayed:

Click **Yes** to connect to the DDM server, or **No** to cancel the connection.

This security mechanism enables you to verify that the DDM server at the specified server name / IP address is the server to which you actually intended to connect.

If the underlying DDM server at a previously used server name / IP address changes, you will see a warning pop-up, so you can cancel the connection if required.

The fingerprint is a unique ID for the DDM server, and is saved locally to your computer.
You can view known fingerprints in the ddm_hosts file at:
- Windows: C:\Users\<user name>\AppData\Local\Dante Controller
- macOS: ~/Library/Application Support/Dante Controller

You can also view the fingerprint for a DDM server instance in the Network & Security settings of the DDM user interface.

**Viewing a Domain**

To select a domain for viewing, select the required domain from the Domain drop-down menu in the Dante Controller main toolbar.

The domains and devices you are able to view and configure are determined by your DDM user account privileges.

The currently logged in user and their relevant domain privileges are displayed next to the Domain drop-down menu.

⚠️ **Note:** When connected to the <unmanaged> domain, Dante Controller will only display devices in the local subnet.

**Virtual Devices**

DDM supports the sharing of audio between domains using the concept of ‘virtual’ devices.
A virtual device is a 'projection' of a real device, which can appear in multiple domains simultaneously, and can be subscribed to by real devices in those domains. It presents in Dante Controller as an independent transmitter, but is really just a logical entity which acts as a subscription proxy for a real device.

Virtual devices are instantiated when real devices are shared between domains using DDM. They cannot be created using Dante Controller.

Using DDM, you can control the domains in which a virtual device appears, and which channels on the real device are exposed by the virtual device. Virtual devices can be assigned their own individual device names.

In Dante Controller, virtual devices are represented using green device names. The number of transmit channels they present is dependent on the number of channels that have been shared on the real device (using DDM).

When you subscribe to a virtual device, the audio you receive is from the real device. Virtual devices cannot subscribe to other devices.

**Note**: The usual configuration options are disabled for virtual devices.
### Legacy Devices

Devices with some legacy (pre-v4.0) versions of firmware can be 'associated' with domains using DDM. This adds them to the relevant clock domain, and allows them to exchange audio with devices enrolled in the same domain, which are also on the same IP subnet (legacy devices do not support audio routing between subnets).

When legacy devices are associated with a domain, they only appear in Dante Controller when you are logged into the relevant domain (unless they have been specifically revealed - see Hidden Legacy Devices below).

**Note:** Dante Controller must be connected to the same subnet as a legacy device in order for it to appear in the Dante Controller interface.

**Important:** When legacy devices are associated with a domain, they are **not** protected from unauthorized access via Dante Controller. Also, when associated, they are placed in a dedicated clock domain and thus can no longer exchange audio with unmanaged devices.

### Hidden Legacy Devices

If a legacy device is moved to an unmanaged Dante network without first being de-associated, it will not appear by default in Dante Controller.

Dante Controller notifies you with a spy icon (next to the network status icons at the bottom left of the UI) if you have hidden devices on your network:

![Spy Icon](image)

To view hidden devices in Dante Controller, select View > 'Show Hidden Devices'.

For more information about legacy devices, see the DDM user guide.

### Domain Credentials

When a device is enrolled in a Dante domain, information about the relevant DDM server and the domain in which it is enrolled is saved to the device. When the device is unenrolled, the domain membership information is cleared, and the device returns to the unmanaged (unenrolled) domain.

If an enrolled device is moved out of the DDM network to another network without first being unenrolled, it will not appear in Dante Controller, because its domain credentials indicate that it is still enrolled in a
domain. In these circumstances it is necessary to clear its domain credentials so that it appears as an unmanaged device in Dante Controller and can be used again.

To clear the domain credentials for a device, it must first be isolated using the same method for resetting a device lock PIN.

1. Isolate the device.
2. Open the Device View for the device.
3. From the Device menu, select Clear Domain Credentials.
Presets

Dante Controller supports the saving and loading of Dante network routing and device configurations, known as 'presets'. A preset file contains configuration and routing parameters for some or all of the devices in the network.

Preset files are saved as xml, and can be edited offline. They are also 'device-agnostic' - they can be shared between networks with different physical devices.

You can use presets to:

- Backup and restore network configurations
- Quickly switch between saved network configurations
- Copy a Dante network configuration from a 'lab' or test network to a live or production network
- Create network configurations for special, or periodic events, and then switch back to the standard configuration when desired
- Quickly apply one or more configuration settings to a number of devices simultaneously - for example, setting all devices on your network to the same sample rate (global configuration)
- Use Dante Controller as an off-line editing tool - off-line edit the saved preset configuration for reuse in new network configuration deployments

About Device Roles

Presets introduce the concept of 'device roles'. When a preset is saved, the configuration and routing for each selected device is saved into the preset as a device role, with the same name as the device from which it was created.

The role is not 'tied' to its originating device. When a preset is loaded into Dante Controller, each role can be applied to its originating device, or to another device (even if it does not support exactly the same functionality). It is a transferable set of device configuration and routing parameters.

For example:

Dave the sound engineer has gigs on Friday and Saturday night at a local venue. On Friday evening before the gig, he sets up his Dante network at the venue, and when he's happy with it, he saves the preset.

After the gig, Dave's annoying boss turns up and steals the mixing console for another job. Dave, however, has a friend with a similar console (conveniently from the same manufacturer, and with a higher channel count) which he can borrow for Saturday's gig.

The next night, Dave simply connects the new mixing console to the network, in place of the old one, and reloads his preset. The new console is now configured exactly like the old one - including all of the relevant channel names, and media subscriptions - and the network functions exactly as before, without any need for further configuration. The gig goes really well, and the band takes Dave out for dinner.

If a role is applied to a device that is different from the role's originating device - for example, a role for console model A is applied to console model B - Dante Controller will identify any issues that might arise
(such as unsupported sample rates) and will display those issues so they can be addressed - or ignored, if they are not important.

Saving Presets

To save a Preset that includes all device parameters:

1. Click the ‘Save Preset’ button in the main toolbar;
2. Select the devices that you wish to include in the preset.
   - Click All to select all devices, or None to clear all selections.
3. Click Save.

To save a Preset that includes a selection of device parameters:

1. Click the ‘Save Preset’ button in the main toolbar.
2. Click Advanced.
3. Select the devices that you wish to include in the preset.
4. Select the parameters that you want to save for the selected devices.
5. Click Save.

Presets are saved as an xml files, which can be manually edited if required, using a text editor.

Parameter Rules

Rx Subscriptions

If ‘Rx Subscriptions’ are included in the preset, and applied to the target system (i.e. ‘Rx Subscriptions’ is checked in the Advanced > Parameters column when the preset is saved, and also checked in the
Preset Elements column when the preset is applied):

All subscriptions for all matched devices on the target system will be updated to match the source system. This means that:

- All subscriptions saved into the preset will overwrite the respective subscriptions for matched devices on the target system. If the subscriptions are identical, they are maintained.
- Any existing subscriptions on the target system that do not exist in the preset will be removed, regardless of whether any subscriptions are defined in the preset.

**Tx Flows (multicast flows)**

The behaviour for TX Flows and Tx Channel Names is different to that of Rx Subscriptions.

If 'Tx Flows' are included in the preset, and applied to the target system (i.e. 'Tx Flows' is checked in the Advanced > Parameters column when the preset is saved, and also checked in the Preset Elements column when the preset is applied):

- All Tx flows saved into the preset will overwrite the respective Tx flows for matched devices on the target system.
- Any Tx flows on the target system that do not exist in the preset will be removed, if at least one Tx flow is defined in the preset. Otherwise (i.e. if no Tx flows are defined in the preset), all Tx flows on the target system are maintained (note this is different to how Rx subscriptions are handled).
- Multicast flows and/or transmit channel names can be manually deleted from the target device prior to or following the preset application.

**Tx Channel Names**

The behaviour for Tx channel names is identical to the Tx flows behaviour described above.

### Applying Presets

To load and apply a saved preset, select **File > Load Preset** from the main menu (Ctrl + L).

Legacy preset files are supported.

The 'Apply Preset' dialogue is arranged in 4 columns, representing the logical steps in applying a preset (from left to right).
**Preset Elements**

Use the Preset Elements column to select the parameters that you wish to apply from the preset to the target network.

If the target network is not identical to the original network (from which the preset was saved), some elements might not be applied successfully. For example, if some devices on the target network do not support the same range of sample rates as the devices on the original network, you could choose not to apply the 'Device Sample Rate' element, and change the sample rates manually instead, once the preset has been applied.

**Preset Roles**

The Preset Roles column lists the roles that were saved in the preset.
You can apply a role to the same physical device from which it was created (if it exists in the target network), or to a different device in the same network, or to another device in a new network.

When a role is applied to the same physical device, or a device of the exact same model, the configuration and routing should be replicated perfectly (although some subscriptions may be 'broken', if the relevant transmitters are not also present on the target network).

Note: This makes presets an ideal way to backup and restore configurations for relatively static networks.

If a role is applied to a different device model or a different type of device, the configuration and routing may not be replicated exactly - the success of the role assignment will vary depending on the functionality and channel support of the target device.

Applying a role to a fundamentally different type of device may not be very successful. For example, applying a role for a fully-subscribed 32-channel mixing console configured at 96kHz to a 2-channel amplifier that only supports 48kHz will be problematic - only two channels can be subscribed (assuming the transmitters are also present), and the sample rate will be rejected.

You can apply a role to multiple devices. You cannot apply multiple roles to one device.

To see which devices a role has been assigned to, click the role. The assigned device/s will be highlighted in the 'Target Devices' column.

Automatic Assignments
Dante Controller will automatically assign roles to devices, based on the following rules:

- If there is a perfect device match (i.e. the physical device in the original network from which the role was created is also found in the target network), the role is assigned automatically
- If there is a device name match, the role is assigned automatically
If a perfect match or a device name match cannot be made, the role will be assigned automatically to a device of the same manufacturer and model, assuming there is an unassigned device of that type.

**Removing Assignments**

To remove an assignment, select the target device and click **Clear** or press the Delete key on your keyboard.

**Manual Assignments**

To manually apply a role to a device:

- Drag the role onto the device, or:
- Select the role in the 'Preset Roles' column and the target device/s in the 'Target Devices' column, and click **Apply**.

The LED icons against each role indicate the assignment status of the role.

- A grey icon indicates that the role has not been assigned to any target devices.
- A green icon indicates that the role has been successfully assigned to one or more target devices.
- An amber icon indicates that the role has been assigned to one or more target devices, but there is a warning condition associated with one or more of the assignments.
- A red icon indicates that the role has been assigned to one or more target devices, but there is an error condition associated with one or more of the assignments.
- A black icon indicates that the role has been assigned to a target device, but the assignment will have a potentially terminal effect on the operation of the network. A preset cannot be applied if any terminal issues are identified.

**Target Devices**

The Target Devices column lists the device names of devices on the currently connected Dante network, and the roles that have been assigned to them (if applicable).
The LED icons against each device indicate the assignment status of the device.

- A grey icon indicates that the device has not been assigned a role.
- A green icon indicates that the device has been successfully assigned a role.
- An amber icon indicates that the device has been assigned a role, but there is a warning condition associated with the assignment.
- A red icon indicates that the device has been assigned a role, but there is an error condition associated with the assignment.
- A black icon indicates that the device has been assigned a role, but the assignment will have a potentially terminal effect on the operation of the network. A preset cannot be applied if any terminal issues are identified.

**Issues**

The Issues column lists all issues identified by Dante Controller. Clicking a role or a target device will highlight the issues associated with that role or role assignment.
The following are 'terminal' issues that could render the network unusable (identified by a black LED icon):

- You cannot apply the same device name to multiple devices.
- You cannot apply the same static IP address to multiple devices.

Other issues may or may not be a problem, depending on your requirements for the network.

**Applying the Preset**

To apply the preset, click OK. Click Cancel to abandon the operation.

**Global Configuration**

You can use the Presets feature for global configuration, i.e. applying one or more configuration settings to a number of devices simultaneously.

For example, if you want to apply the same sample rate to all devices on your network:

1. Set one of your devices to the required sample rate.
2. Click the Save Preset button.
3. Click None, then select only the relevant device.
4. Click Advanced.
5. Click None, then select the 'Device Sample Rate' checkbox.
6. Click Save.
7. Load the preset (File > Load Preset).
8. In the 'Preset Roles' column, select the relevant role.
9. In the ‘Target Devices’ column, click **Select All**.
10. Click **Apply** then click **OK**.

This will set all devices to the same sample rate, but will leave all other device configuration settings untouched.
Dante Updater

Dante Updater is a desktop application that allows you to update the Dante firmware and software on Dante hardware devices. It is installed automatically when you install Dante Controller.

The application is linked to an online database containing firmware update files for products from multiple manufacturers. When the application is connected to a Dante network, it scans the network and identifies the firmware versions for each discovered Dante device.

If newer firmware for any device is available in the online database, you can update the device using the online file, or download the firmware file to your local machine for offline use. If firmware is found for multiple devices in your network, you can choose to update all devices simultaneously.

You can always easily control which devices get updated.

Launching Dante Updater

To launch Dante Updater, click the button in the main toolbar:
If Dante Updater identifies one or more devices on your Dante network for which new firmware is available, a notification icon is displayed on the Dante Updater button in the main toolbar:

Launch Dante Updater to review the available updates and update the device(s).
Troubleshooting

Fanout

About Transmit Flows

Transmit flows are 'streams' of media packets which supply data between devices. Dante devices can support a finite number of transmit flows, depending on their specific hardware configuration and firmware version.

Dante supports two types of flows - unicast and multicast.

**Unicast** flows are used to supply media to specific devices, and support up to 4 channels of audio simultaneously, or 1 channel of video. So if you subscribe 4 audio channels on a receiver to 4 audio channels on a single transmitter, that audio data will be supplied using one flow. If you were to then subscribe a fifth audio channel, a second flow would have to be created.

If you were to subscribe 4 different receivers to the same audio channel on a single transmitter, Dante Controller would have to create 4 unicast flows, because the audio data is going to 4 different places. In this case, it would be better to create a multicast flow.

A **multicast** flow 'broadcasts' media across the network, so multiple receivers can subscribe to the media, but the transmitter is only using one of its available flows. Multicast flows can be configured with up to 64 channels (depending on the Dante device type). However, multicast media traffic can propagate throughout an entire network, using up bandwidth on every link in the network. 100Mbps links in particular are easily saturated when large numbers of multicast flows exist (and would be overwhelmed by 1 channel of video). Therefore, multicast flows should only be used when there is a good reason to do so.

**Note:** IGMP snooping must be enabled on network switches that will be carrying Dante video on 1Gbps network infrastructure. Refer to your switch manufacturer's documentation for information about enabling IGMP snooping.

If you subscribe a number of devices to one channel via unicast, Dante Controller will alert you with the following message: "Fanout Configuration detected."

If you then exceed the supported number of transmit flows, any further subscriptions will fail, and the tooltip for the failed subscription will read 'No more flows (TX): transmitter cannot support any more flows, reduce fan out by unsubscribing receivers or switching to multicast.'
Messages on Startup

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Meaning &amp; Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Dante Controller was unable to connect to the Dante Control and Monitoring</td>
<td><strong>Affects:</strong> Windows only.</td>
</tr>
<tr>
<td>manager. Dante Controller cannot function without this connection. This</td>
<td><strong>Meaning:</strong> The 'Dante Control and Monitoring' service is not responding. This</td>
</tr>
<tr>
<td>problem is most likely caused by the Dante Control and Monitoring ('conmon')</td>
<td>can occur after a computer has been in sleep mode.</td>
</tr>
<tr>
<td>service or daemon stopping unexpectedly. Click OK to restart Dante Controller.</td>
<td><strong>Action:</strong> Restart Dante Controller. In the event that does not work, reboot</td>
</tr>
<tr>
<td>You may also need to manually restart the Dante Control and Monitoring service,</td>
<td>your PC, or restart the Dante Control and Monitoring service via Control Panel &gt;</td>
</tr>
<tr>
<td>or the computer, if the problem reoccurs.'</td>
<td>Administrative Tools &gt; Services.</td>
</tr>
<tr>
<td>'The installed version [x] of the Dante Control and Monitoring service</td>
<td><strong>Affects:</strong> Windows and macOS.</td>
</tr>
<tr>
<td>('ConMon') is out of date. This version of Dante Controller requires ConMon</td>
<td><strong>Meaning:</strong> Usually this is because the required service (ConMon) that is</td>
</tr>
<tr>
<td>version [x] or later. Please reinstall Dante Controller to resolve this</td>
<td>installed with Dante Controller has been overwritten with an older version by</td>
</tr>
<tr>
<td>issue. Dante Controller will now exit.'</td>
<td>another Dante software product installation.</td>
</tr>
<tr>
<td>'The installed version [x] of the Dante Discovery service is out of date.</td>
<td><strong>Action:</strong> Reinstall Dante Controller. This will update the ConMon service to</td>
</tr>
<tr>
<td>This version of Dante Controller requires Dante Discovery version [x] or</td>
<td>the latest version.</td>
</tr>
<tr>
<td>later. Please reinstall Dante Controller to resolve this issue. Dante</td>
<td><strong>Meaning:</strong> Usually this is because the required service (Dante Discovery) that</td>
</tr>
<tr>
<td>Controller will now exit.'</td>
<td>is installed with Dante Controller has been overwritten with an older version by</td>
</tr>
<tr>
<td></td>
<td>another Dante software product installation.</td>
</tr>
<tr>
<td></td>
<td><strong>Action:</strong> Reinstall Dante Controller. This will update the Dante Discovery</td>
</tr>
<tr>
<td></td>
<td>service to the latest version.</td>
</tr>
</tbody>
</table>

Computer Configuration Checklist

Before installing Dante Controller, you must be logged in to your computer as a user with administrator privileges.

To be correctly configured for use with a Dante network, the computer should have:

- Dante Controller installed
- The correct network interface/s selected
- The correct IP addresses in use

Third-party firewall configuration

- Standard Windows and Mac firewalls are typically configured on installation.
- Third party firewalls will need to be manually configured.

If your computer has a third-party firewall installed, please read the Dante Controller and Dante Virtual Soundcard User Guides for detailed information about firewall requirements and configuration.
Troubleshooting Dante IP Address Configuration

All devices in a Dante network, including Dante Virtual Soundcard, must be using IP addresses from the same network. When using Dante Virtual Soundcard or Dante Controller, your PC or Mac must be connected to the Primary and/or Secondary Dante network, and must have a correct IP address.

Note: If a device name is shown in red, it means Dante Controller has automatically detected an error condition, such as an IP address configuration issue, or the device has entered failsafe. Double-click the red device name to see more information.

Correct IP configuration

Dante hardware devices are set to obtain their IP address automatically from the network. They will either:

- Automatically assign themselves an address in the range 169.254.*.* (172.31.*.* for the secondary network if present), or
- Obtain an IP address from a DHCP server if it is present on the network

Your PC or Mac TCP/IP network configuration set should be set to 'Obtain an IP address automatically'. This way it will automatically acquire a Link Local automatic IP address in the same network as other Dante devices. If a DHCP server is present, the computer and Dante devices will all acquire their IP addresses via DHCP.

Possible IP network configuration mistakes

Possible network configuration errors are listed below. Dante Controller will try to automatically detect these. If detected the offending device will be displayed in red.

Incorrect PC/Mac IP configuration

- Accidentally having multiple network interfaces with addresses in the same subnet
- If your secondary network is using Link Local (no DHCP server), all devices on that network will be in the 172.31.*.* range. The secondary network interface for the computer must be manually configured (using static IP addressing) to the same range.

Incorrect general IP configuration

- Accidentally having multiple DHCP servers on the same network
  Unusual - for example, someone may have a PC connected to the network with a DHCP server running that they're not aware of.
- Incorrectly configured static IP addresses
  You shouldn't typically need to configure static IP addresses at all. If for some reason you do, it must be in the same subnet as the rest of the network.

Incorrect redundant network configuration

Setting up a redundant network is described in 'Routing Audio'. There are a few ways to incorrectly configure a redundant network. More than one of these can be present at the same time.

- Connecting the secondary interface of a Dante device to the primary network
Most commonly by either misunderstanding how redundancy works, and using only one switch with all cables connected to it; or correctly using two switches or networks, but accidentally connecting one secondary cable to a primary network switch

- Joining the primary and secondary Dante networks
  - By connecting primary and secondary switches, or perhaps just using one switch.
- Multiple interfaces on the same device using the same IP address subnet
  - Possibly by having the same DHCP server on both primary and secondary networks, or both DHCP servers configured to serve the same IP addresses. Also, mixing DHCP and Link Local on the same network can cause issues. It is often necessary to have all devices and the computer on either DHCP or Link Local.

### What are the symptoms of using the wrong network interface on my computer?

If you have more than one wired network interface, and Dante Controller is not using the interface the rest of the Dante devices are connected to:

- Dante Controller cannot see any Dante devices
- Dante Virtual Soundcard is not sending or receiving any audio when it is expected to

### How do I check which network interfaces Dante Controller is using?

- The selected network interfaces can be viewed or changed via the ‘interface selection’ button in the Network View toolbar of Dante Controller.

![Configure Dante Interfaces in Unmanaged mode](image)

- If the Dante network is standalone and does not have a DHCP server installed, the addresses should be in the range 169.254.*.*
- If the Dante network is using a DHCP server, the IP addresses should conform to the addressing scheme it is using (as shown in the image above)

### How do I check IP addresses for all devices on my network?

- Use the Device Info tab to view the IP addresses of all the devices on your network.
- The Primary Address of all devices should follow the same IP address scheme (e.g. 169.254.*.* or 10.12.0.*). Same for secondary addresses...
- Note that some older Dante devices or devices running older firmware may not show this information.

**Troubleshooting Switch Configuration and Cabling**

Cables are the most vulnerable part of a network system. If you suspect cabling issues, check for:
- Faulty or manually terminated cables
- Unplugged/badly connected Ethernet cables
- Incorrectly configured switches
- Dante devices removed or turned off

**Symptoms of switch or cabling issues**

- You cannot see (some) devices in the Dante Controller network view
- Dante Controller shows orange “unsuccessful subscription” icons, which usually means a device that was present earlier is now missing
- Faulty cables can lead to intermittent faults, which may be heard as dropped samples or “cracks” in the audio
- Dante devices may appear and disappear in Dante Controller

**Switch and Cabling Checklist**

- Are all the connected link/status lights on the switch lit, or flashing as expected?
  - Is the switch powered on?
  - Is the cable correctly plugged in at the switch and the PC or equipment?
- Is the switch correctly configured?
  - Perhaps QoS or VLANs have been incorrectly set up
- Are you using a switch from another application with an unchecked or tested configuration?
  - Consult the switch manual and check the switch configuration

**Note**: Video (Dante AV) devices require at least 1Gbps ports and cables.
Appendix

Resolution and Timing for Dante AV Devices

This is a description of how video resolutions and timings are negotiated between the HDMI source attached to a Dante AV Tx endpoint (transmitter) between the Dante AV Tx and Rx endpoints, and the Dante AV Rx endpoint (receiver) to the HDMI sink/display.

Automatic Operation

Resolution and timing configurations can be set to Auto on the Dante AV transmitter. In this case, when a source device, such as a camera, computer, or BluRay player, is connected via the input HDMI port to the Dante AV transmitter, the Dante AV transmitter provides the complete list of supported resolutions and timings to the source device using EDID (Extended Display Identification Data). The source device then selects one of the available resolutions and timings from the list and initiates sending a signal.

![Diagram of HDMI resolution and timing negotiation]

Figure 3 - Dante AV HDMI Encode (Auto)

Based on the incoming signal resolution and timing, the network connection between the Dante AV transmitter and Dante AV receivers is configured. The codec will compress video to match the source EDID resolution and timing.

It is entirely up to the source device to select the input video resolution based on the available EDID list presented by the Dante AV transmitter. The Dante AV transmitter provides 49 different resolution and timing settings.

On the receive end, the Dante AV receiver requests the EDID from the sink/display device attached to the output HDMI port. It then compares the available resolutions and timings to the subscribed Dante AV transmitter. Where possible, the signal is decoded and passed at native resolution (the same resolution and frame rate as the source). However, if the EDID of the sink/display only provides resolutions lower than the source, the video will be downscaled to match the capabilities of the sink/display. There is no upscaling available with Dante AV receivers.
The Dante AV receiver is capable of downscaling the following:

- 4096x2160p to 3840x2160p
- 3840x2160p to 1920x1080p
- 1920x1080p to 1280x720p

The frame rate, or timing, of a video signal transported over Dante AV cannot be modified. At present, if the source provides a 60fps signal into the Dante AV transmitter, then all sinks to Dante receivers must be capable of supporting 60fps. Frame rate will generally be favored over resolution.

For instance, if the source is providing a 3840x2160p60 input to the Dante AV transmitter, and the sink device (for example, a display monitor) attached to a Dante AV receiver can only support 3840x2160p30, you might get 1920x1080p60 as the output.

If the frame rate is not supported by the sink device attached to the Dante AV receiver, then no signal will be passed.

### Manual Operation

Using Dante Controller, you can manually set the input resolution, frame rate, color bit depth, and chroma subsampling for the Dante AV transmitter. By doing so, you will limit the EDID list of supported resolution and timings to only the manual settings. The HDMI source will need to support whatever setting is made. The codec/network transmission will follow the input EDID settings made using Dante Controller.
Figure 5 - Dante AV HDMI Encode (Manual)

After you save your resolution and timing settings using Dante Controller to the Dante AV transmitter, the Hot Plug Detect channel on HDMI is toggled off and on in order to initiate an EDID renegotiation with the source. It is up to the source to detect the Hot Plug Detect signal and initiate renegotiation using the new EDID list and select the appropriate input resolution and timing.

On the Dante AV receiver, the function is identical to automatic mode.

Figure 6 - Dante AV HDMI Decode (Manual)
Index

A
Access control failure 22
AES67 87
AES67 Config 88
AES67 Flow 98
Ancillary Channels 26
Applying Presets 110
Auto-configuration 19
Available Channels 72, 74
Avid Config 91

C
Cabling 123
Cabling issues 123
Cannot change 22
Changing Receive Channel Names 72
Changing Tx channel Names 74
Channel 71
Channel Groups 51, 69
Channel metering 71, 73
Channel Names 22
Checking for Updates 18
Clear Config 84
Clear Domain Credentials 107
Clock Domains 55
Clock frequency offset 58
Clock Leader 55
Clock offset 59
Clock Source 53
Clock stability 56
Clock Status 53
Clock Status Monitor 56
Clock Status Monitoring 56
Clock Sync Locked 58
Clock Sync Unlocked 58
Clock Sync Warning 58
Clock Synchronization 28, 76
Clock Types 28
Isolate a Device 32

Keep IP settings 84

Latency 29
Latency Errors 63
Latency for Video Devices 30
Latency Setting 63
Latency Tab 77
Leader Clocks 55
Legacy Devices 106
Locked receiver 22
Locked transmitter 22
Locking 31
Locking a Dante device 31
Log 57

MAC address 56, 76
Manufacturer 75
Media Formats 25
Memory 15
Menu bar 43
Messages 120
Mismatched clock domains 21
Model Name 52
Monitoring 33
multicast 119
Multicast 23, 25, 69, 94
Multicast Address Prefix 89
Multicast Transmit Flows 40
Multiple Media Channels 20
Mute 53
Mute Status 76

Network Config 85
Network Interface 34
Network Status 62
Network View 42
No more flows (TX) 22, 119
No Receive flows 21

Orange text 66

Packet Errors 63
Parameter Rules 109
PIN reset 31
Plugins 84
Precision Time Protocol 28
Preferred 76
Preferred Encoding 83
Preferred Leader 28, 54
Presets 108
Primary Address 52
Primary Interface 76
Primary Link Speed 52
Primary Rx B/W 63
Primary Status 62
Primary Tx B/W 62
Primary v1 Multicast 54
Primary v2 Multicast 54
Processor 15
Product Version 52
PTP 28
pull-up/down 82

Receive channels 19
Receive Tab 70
Redundancy 24
Redundant Networks 28
Refresh 69
Rename Device 82
Reset Device 84
Reset PIN 31
Residual Connections 33
Resolution and Timing for Dante AV Devices 124
Routing 23
Routing for Video Devices 26
Routing View 46
RTP Multicast Address Prefix 89
Rx 19
Rx Utilization 76

Sample Rate 82
Saving Presets 109
Secondary Address 52
Secondary Interface 77
Secondary Link Speed 52
Secondary network 35, 121
Secondary Rx B/W 63
Secondary Status 62
Secondary Tx B/W 62
Secondary v1 Multicast 54
Signal 71, 73
SMPTE 87
SMPTE Flows 98
Status Bar 45
Status Tab 74
Subnet mask 35
Subscribing 20
Subscription status 20, 24
Subscription Tooltips 21
Sync 53
Sync Status 76
Synchronization 28
System Requirements 15

Tabs 45
The installed version [x] of the Dante Control and Monitoring service ('ConMon') is out of date. 120
The installed version [x] of the Dante Discovery service is out of date. 120
Tool bar 44
tooltip 21
Transmit channels 19, 73
Transmit Flows 74, 119
Transmit Tab 72
Transmitter is locked 22
Troubleshooting 121, 123
Troubleshooting Switch Configuration 123
Tx 19
Tx Channel Names 110
Tx Flows 110
Tx Scheduler failure 21
Tx Scheduler Failure 29
Tx Utilization 76

Unicast 23, 95, 119
Unicast Delay Requests 83
Uninstalling Dante Controller 18
Unlocking 31
Unlocking a Dante Device 31
Unsubscribing Audio Channels 20
Updating Dante Controller 18
Upgrade mode 66
USB 26

Video Channels 26
Video Devices 26
Video latency 30
View 44, 69
Viewing Domains 102
Virtual Devices 104

Warning 22
Web Config 69
Wi-Fi access point 40
Wi-Fi and Multicast 40
Wi-Fi network connection 40